[image: image1.png]KARABUK
uuuuuuuuuuuu




[image: image212.png]



	[image: image213.png]


KBT106
Grafik ve Animasyon I
	[image: image214.png]


[image: image215.png]


2


[image: image216.png]




[image: image217.png]


[image: image271.png]| & scenet





[image: image218.png]



[image: image219.png]



KBUZEM
Karabük Üniversitesi

Uzaktan Eğitim Araştırma ve Uygulama Merkezi
Haftanın Konuları (İçerik)

Referanslar

MEGEP Eğitim Modülleri
Vildan Özfenerci
A. GRAFİK

1. Giriş 

Grafik – Animasyon dersinin ilk bölümü konusu olan Grafik için bir grafik editörü programının seçilmesi gerekiyor.  Her türlü ortam ve aygıt için etkileyici dijital medya üretiminde öncü Adobe firmasının  sunduğu “Creative Suite” paketi bile birden fazla grafik editörü içermekte. Biz bu ders kapsamında Adobe Photoshop programını esas alarak bu program yardımı ile grafik geliştirmeyi öğreneceğiz.
2. Genel Bilgiler

2.1 Piksel 

Bütün Bitmap programlarda olduğu gibi PhotoShop'ta da ölçü birimi pikseldir. Pikseller kare şeklindedir ve görüntünün en küçük birimidir. Digital görüntüler yana yana gelen piksellerden oluşur. Piksellerin kendi başına en ve boy değerleri yoktur. Öyleyse nasıl, şu kadar cm'lik şu kadar piksellik gibi cümleler kurabiliyoruz? :) 

Kendi başlarına ölçüleri belli olmayan piksellere, ölçülerini biz veriyoruz diyebiliriz. 10 cm uzunlukta 10 piksel varsa, her piksel 1 cm demektir.
10 cm uzunlukta 100 piksel varsa, her piksel 1 mm. demektir...

Aşağıda, sağdaki görüntü, fotoğrafı 16 kat büyüttüğümüzde görebildiğimiz piksellerdir.  Her piksel kare biçimindedir ve her pikselde sadece 1 renk vardır. Yani bir pikselin bir kısmı açık bir kısmı koyu, ya da yeşil, koyu yeşil olmaz... Bu tür renk geçişleri (degrade) farklı renkte piksellerin yan yana gelmesinden oluşur. 
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2.2 Rezolusyon 
Bir resmin piksel yoğunluğunu yani, PPI (Pixcel Per Inches) 1 inç karede 
(1 inç = 2.54 cm) bulunan piksel sayısı. Image/Image Size bölümünden ulaşabileceğiniz bu pencere, gerekli değişiklikleri yapabileceğiniz yerdir.
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          Örnek1 


Bir resmi büyütür küçültürken büyüklük ile resolasyonu birbirine bağlarsanız, resmin cm cinsinden büyüklüğü değişmiş görünse bile, görüntü büyüklüğü değişmez. Aşağıdaki örnekte resmin genişliği 5 cm yapılmasına rağmen, iki resim arasında büyüklük farkı yoktur. Çünkü Bitmap programlar, sonuçta kaç piksel olduğuna bakarlar. İşaretlenmiş kısımda genişliğin 49 piksel olduğunu görüyorsunuz.
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        Örnek2
Ama bu 3lü bağlantıyı kurmadan Rezolusyonu değiştirseniz, resmin büyüklüğü de değişir.
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	49 piksel
	34 piksel
	24 piksel
	17 piksel


2.3 Anti-aliasing 
Piksellerin kare biçimli en küçük resim elemanı olduğunu tekrarlayalım. Bir resim piksellerin toplamından meydana gelir. Bitmap programlar, mozaik döşer gibi bunları yanyana getirip görüntüyü oluşturur. Düz alanlarda sorun yoktur, ama yuvarlak dönmesi gereken yerlerde tırtıklı bir görüntü ortaya çıkar.

Bunu çözmenin yolu, rengin kenarına kırıklı görüntüyü biraz azaltacak, daha açık pikseller yerleştirmektir. Anti-aliasing işte budur...

Bu seçeneği genel olarak aktif halde tutmanız, resimlerin kırıklı görünmesini engeller. 
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2.4 İnterpolasyon 

Piksel temelli programlarda yaşanan sorunlardan birisi resmi büyütmedir. Resim büyürken araya pikseller eklenir. Program, en yakın piksellerin değerini esas alarak, araya pikseller ekler. 
Elinizdeki orjinalden daha büyük bir tarama yapacaksanız, bunu baştan hesaplamalısınız. Bir örnekle bu hasaplamanın mantığını inceleyelim.
Elinizde 14x10 cm bir resim olduğunu ve bunu 50 x 70 cm boyutlarına büyütmeniz gerektiğini varsayalım. Scanner'ınızın en üst tarama resulation da, mesel, 900 pixsel/inc olsun.


1. Önce orjinalin gerçek ölçülerinde (10 cm x 14 cm) ve 900 pixsels/inch'te tarama yapalım.  4961'e dikket edin…
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2. Ofset baskı ve printer çıkış için 300-310 gibi rakamlar geçerliyse de, resolution'un 270 olması da idare ediyor... (Kağıt cinsine göre 60, 70, 80'lik tramla basılır) Buradan hareketle resolution'u 270 getirdiğimde, resmin boyutları 46,67 x 33,33 cm e ulaşıyor. Dikkat ederseniz 4961 piksel yine aynen görünüyor...

İşte işin sırrı burada. Resimde interpolasyon olmuyor... (Photoshop, resim büyüdüğü için kafasına göre araya piksel eklemek zorunda kalmıyor.
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3. Büyütmemiz gereken ölçü ise 50x70 cm idi. Resolution 180 olduğunda, interpolasyonsuz bu ölçüye ulaşabiliriz ama bu da yeterli bir kalite sağlamayacaktır.
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4. Demek ki resim ilk tarandığında (Resolution 270 e razıysak) 1350 pixsel/inc olarak taranmalı. (1/1 taradığını varsayıyoruz, aslında dram scannerlar bu hesabı kendisi yapıyor). 7441'e dikkat edin…
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5. Ölçü 50x70 ve resolution 270 ...

7441 hala aynı yani interpolasyon yok... 
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Buradan çıkan bir sonuç daha var: Yukarıdaki örnekleki gibi bir büyütme istiyorsak ve scanner'ımızın kapasitesi daha yüksek taramaya olanak vermiyorsa, bu işi drum scanner'la halletmeniz gerekiyor.

İyi sonuç alınması gereken işlerde, tarama masrafından kaçmamak, bu işi masaüstü scanner'la değil, renklerin doğru olarak taranacağı bir Drum scanner kullanmak en iyi çözüm. Yani bu iş de profesyonellerine bırakılmalı...

2.5 Tarama yaparken bilmeniz gerekenler 

i. PPI (Pixel Per Inc) ya da PPC (Pixel Per cm)
1 inç'de (1 inç = 2.54 cm) ya da 1 cm'de bulunan piksel sayısı.
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Taradığınız resmi web'de kullanacaksanız 72 PPI taramanız gerek.
Ofset baskı için durum değişiyor. Baskının yapılacağı kağıt cinsi önemli. Gazete kağıdı ile kuşe kağıda yapılacak baskı arasında fark var. 
Gazete kağıdına 40 lık tramla basılırken, kuşe için 70 ya da 80 lik tram kullanılması gerekir. 1. Hamur kağıt için 60 lık ... Her ne kadar bunlar LPI değeri ile belirleniyorsa da, LPI ile PPI değeri arasında da bir ilişki var...

Buradan hareketle tarama Rezolusyonu da değişiklik gösterir.
Ama kabaca 250 ile 350 PPI arasında olması gerektiğini söyleyebiliriz.

En çok kullandığınız kuşe kağıda baskı için: 306-310 PPI 

Tabii bu Rezolusyonu önerirken, resmi orijinal boyutta tarayacağınızı varsayıyorum. Büyütme yapmanız gerekiyorsa interpolation bölümünü okuyun.
ii. LPI (Line Per Inc)
Film pozlanırken 1 inç yüksekliğindeki (2.54 cm) alana atılan satır sayısı.

Ofset baskıda tramlarla iş basılır. Tramlar, bir birine özel açılar ile dizilmiş noktacıklardır ve sonuçta aralarında belli bir miktar boşluk vardır. Paralel çizgiler halinde sıralandıklarını düşünebilirsiniz. Tramlar yardımı ile Cyan, Magenta, Yellow ve Black mürekkeplerini kağıda aktarır. Bu çizgilerin yoğunluğu ve aralığı baskı kalitesini belirler. En çok kullanılan tram aralıkları 175, 150, 133, 120, 110, 100, 85 ve 65 LPI'dir. 

Yukarıda yazdığımı yeni eklemelerle genişleteyim.

3. hamura baskı yani 40-50 lik tram = 110 - 130 LPI 
1. hamura baskı yani 60 lık tram = 150 LPI
Kuşe kağıda baskı 70 lik tram = 175 LPI
Kuşe kağıda baskı 80 lik tram = 200 LPI 

Peki bu değerleri biliyorsunuz, resolasyonu nasıl hesaplayacaksınız? Yani PPI ne olmalı? Photoshop yapmayı düşündüğünüz baskıya uygun tarama Rezolusyonunu size bildiriyor. Nasıl mı? 

	[image: image21.png]Image

Fixel Dimensions: 60K (was 1.37M)

oK
width: [142 Dixels
veignt: [z Dixels
Print Sze:
widt: 5 am -
&
T o |
Besoltion:  [72 Dixels/inch
I Constrain Proportions
7 Resample [mage: [ Bicubic =





5x5 cm boyutunda bir işiniz olduğunu düşünün. Bunu Kuşe kağıda basacaksınız. Normal kalitede... Herhangi bir Rezolusyonda 5x5 cm lik bir Photoshop dökümanı açıp deneyelim. Auto butonuna tıklayın. Aşağıdaki pencere karşınıza gelecek. 
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Baskımızın özelliği gereği 175 LPI bize yetiyor. Screnn bölümüne 175 yazıp tabloyu okeyleyin. Önce Good seçeneğinde deniyoruz.
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Sonucu görüyorsunuz. 5x5 cm için Rezolusyon 263 olarak hesaplandı.
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Şimdi de Best seçeneğiyle deneyelim...
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Bu kez Rezolusyon olarak verilen değer 350 PPI.

 Dikkat ettiniz mi bilmiyorum. 
Good seçeneğinde: LPI x 1,5 = PPI (175 x 1,5 = 262,5)
Best seçeneğinde: LPI x 2 = PPI (175 x 2 = 350)

Bu demektir ki, Rezolusyonun ne olduğunu kendimiz de hesaplayabiliriz. 
Yani: LPI x (1,5 ya da 2) = PPI

Unutmayın büyütme yapacaksanız, interpolasyona neden olmamak için, tarama Rezolusyonunu büyütme oranına göre hesaplamak zorundasınız. 
Bunun için interpolation bölümünü okuyun.


iii. DPI (Dot Per Inc) 
Çıkış cihazlarında 1 inç'te (2.54 cm x 2.54 cm) noktalanan (yani basılan) ya da pozlanan piksel sayısı. 

Renkli/siyah-beyaz çıkış yapan yazıcılar baskılarını nokta vuruşları ile yaparlar. Her inç'e noktalanan piksel sayısı makinenizin özelliğine göre değişir. Çünkü her yazıcının kullanabileceği en yüksek nokta yoğunluğu farklıdır. 300 DPI, 600 DPI, 1200 DPI gibi... CMYK adı verilen Cyan, Magenta, Yellow ve Black ile kağıdın üzerinde küçük mürekkep noktacıkları basar, bunlar da bildiğimiz renkleri oluşturur. 

Film çıkış cihazları da çözünürlüğü DPI'e, yani bir Inch başına vurduğu nokta sayısına göre hesaplar. İnç başına düşen nokta sayısı çok azalırsa kalite kaybı olur ama gerekenden fazla olursa daha iyi sonuç alırız diye düşünmeyin. Yüksek çözünürlüklerde, sadece gereksiz büyümüş dosya boyutu ve anlamsız bekleyişler yaşarsınız.

DPI = 16 x LPI değerinde olması Resimdeki renklerin (Filmlerin siyah beyaz olduğunu biliyorsunuz, yani oradaki gri dağılımının) sağlıklı basılmasını sağlar.

2.6 Görüntü Formatları

Masaüstü yayıncılıkta programlar bir birlerinden dosya alışverişinde bulunarak çalışırlar. Bir resmi veya vektörel çizimi oluşturduğumuz uygulama programından bağımsız hale getirip sayfa düzenleme programına ya da vektörel programlara aktarmak için farklı bir formatta kaydetmemiz gerekir.  Yaygın kullanılan görüntü formatlarından bazıları:
i. PICT
PICT formatı bütün programların ortak kullandığı dosya formatıdır. Herhangi bir uygulama programına aktarıldığında resim bilgisi sayfaya dahil olur. Görüntü diskinizden silinse dahi baskı aracı sayfayı basarken PICT dosyasını aramaz. 
Logo düzenleme ve yeniden oluşturma işlemleri sırasında PICT olarak kaydedilmiş görüntüyü, Illustrator ve FreeHand programlarına aktardığımızda, llustrator programı isteğe bağlı olarak dosya aç komutuyla görüntüyü açar ve sayfaya Template (yarı saydam/arka plan) olarak yapıştırır. Böylelikle bu görüntünün üzerinden vektörel olarak çizimimizi yapabiliriz.
FreeHand programı ise resim al komutuyla sayfa içine resim olarak aktarır, görüntüyü Template (yarı saydam/arka plan) yapmak için Layer paletinden background (arka plan)'ı seçerek vektörel olarak çizebiliriz. PICT ile sayfa üzerine yapıştırdığınız görüntüyü ancak sunum için kullanabilirsiniz. Masaüstü Laserlerde görüntü pürüzsüz çıkabilir ama baskı ortamına aktardığınızda görüntü kırıklaşıp fluğ bir hal alır. Sunum işiniz bittiğinde görüntüyü yeniden yüksek (HiRes) taratıp (304.8 Dpi) sayfa üzerine yerleştirmeniz gerekir. 

ii. EPS
EPS formatı hemen hemen bütün çizim ve sayfa düzenleme programları tarafından desteklenir. Photoshop programında, döküman Bitmap modunda kaydedilirken Transparen Whites (Beyazları transparan yap) seçeneği işaretlenerek kaydelirse dosyada beyaz alanları şeffaf tanımlayabilmesidir. Renkli bir döküman EPS olarak kaydedilecekse olası baskı problemlerini önlemek için CMYK moduna geçirilmiş olmalıdır. 

Kaydederken karşınıza çıkan dialog kutusunda; 
Preview: EPS dosyanızı diğer programlarda kullanırken resmin nasıl göründüğüne dair bir öngörüntüdür. Bu sayede resmi istediğiniz kadraja yerleştirebilirsiniz. Bu menüdeki Macintosh seçeneği bütün programların kullanabileceği bir PICT öngörüntü oluşturur. Dosyanızın öngörüntüsünü TIFF seçerseniz bu dosyayı IBM uyumlu bilgisayarlarda da kullanabilirsiniz.
Encoding: Bilgilerin dosya içinde ASCII yada Binary şeklinde saklanmasını isteyebilirsiniz. Binary kodlama ASCII'nin yarısı kadar yer tutar. Genellikle Binary kullanılır fakat bazı PostScript hatalarını resim dosyalarını ASCII kaydederek önlemeyi deneyebilirsiniz. 
Clipping Paths: Photoshop 4,0 versiyonunda görüntü dosyanız üzerinde dekupe etmek istediğiniz bölgeyi kapsayan path'i seçeceğiniz bölümdür. Photoshop 5,5 versiyonu, eğer kaydet komutunuzdan önce path penceresinden çizimi clipping etmişseniz otomatik olarak dekupe edilmiş görüntüyü dosya içine yazar. 
DCS1: CMYK olarak kaydedilmiş EPS dosyalar için geçerlidir. DCS yüksek çözümlemeli renk bilgisini içeren 4 adet (C,M,Y,K) dosya ve beşinci olarak sayfa düzenlemede kullanacağınız bir ana dosya oluşturur. Ana dosya 72 dpi bir öngörüntü dosyasıdır, 4 adet yüksek çözümlemeli dosya baskı sırasında kullanılır. Dikkat etmemiz gereken bir nokta, DCS'nin yarattığı sayfa düzenlemede kullanacağınız öngörüntü dosyasının ismini asla değiştirmeyin. Eğer değiştirirseniz dosyanız baskı sırasında yüksek çözümleme dosyaları bulamayacağından öngörüntü dosyasını (72 Dpi) basar.
Kaydetme sırasındaki seçeneklerinizin ilki, öngörüntünün nasıl olacağı, ikincisi dosya biçimi, üçüncüsü ise yüksek çözümleme dosyalarının sıkıştırma biçimi ile ilgilidir.
DCS2: CMYK+Ekstra renkler için kullanılan dosya kayıt biçimidir. Resim üzerinde ekstra (Beta) kanal kullandığınızda dosyanız içindeki beşinci veya daha fazla renk kanallarını bastırmak için kullanacağınız format biçimidir. 
EPS ayrıca vektörel programların (Illustrator ve FreeHand) sayfa düzenleme programlarına dosya aktarım formatıdır. Vektörel dosyalar eps formatında kaydedilmez ise sayfa düzenleme ve resim programları kendi dosya içlerine alamazlar. Örneğin Photoshop programı vektörel çizimli bir eps dosyasını restarize ederek (piksele çevirerek) kendi bünyesine alabilir. QuarkXpress programı EPS formatlı dosyaları bir öngörüntü (Preview) dosyası oluşturarak sayfa üzerine yapıştırır.

iii. TIFF
TIFF formatı bilgisayarlar arası ortak bir dosya formatıdır. Tüm programlar tarafından desteklenir. Bu formatta kayıtlı dosyalar, herhangi bir uygulama programının sayfa içine alındığında görüntü ve zeminin renk değerlerini azaltma ve değiştirme olanağı verir. Örneğin farklı farklı renklerde kullanacağımız bir görüntü yada logoyu TIFF formatla kaydadip sayfaya yapıştırdığımızda renklerini değiştirebiliriz. Bu yolla her renk değişikliğinde onu yaratan uygulama programını açıp yeniden renk verip yeni dosyalar oluşturmamış oluruz. 

Kayıt sırasında LWZ seceneği dosyayı sıkıştırarak kayıt edilmesini sağlar ancak, bu seçenekle kayıtlı dosyaları film baskı araçları desteklemez. Bu kayıt biçimiyle gönderdiğiniz dosyaları, film servisinize bildirirseniz doğacak sorunları baştan halletmeş olursunuz. 

iv. JPG 
JPG formatı, resim işleme programlarının yüksek Mb'lı dosyaları sıkıştırarak disk üzerinde kayıt edebileceğiniz bir formattır. JPEG veya JPG formatının özelliği gerçek renk değerlerini içermesidir. Bu nedenle fotoğrafik (çizgisel/grafiksel olmayan) görüntüle için kullanılmalıdır.

JPEG sıkıştırma yöntemi görüntünün algılanması için zorunlu olmayan detayları bulup atan ve dosyayı bu şekilde sıkıştıran bir format olduğundan kayıplı formatlar arasında yer alır. Kaybolan ayrıntılar ve sıkıştırma oranı arasında bağlantı bulunduğundan bu dengeyi iyi korumak gerekmektedir. Daha fazla sıkıştırma daha fazla detay kaybı daha az sıkıştırma daha büyük dosya demektir. Kaybedilen detayların geri getirilmesi söz konusu olmadığından dosyanın bir kopyasını mutlaka alınmalıdır. 

v. BMP
BMP Windows ve Microsoft'un PCX formatını değiştirerek geliştirdiği bir formattır. Windows 3.1 ve 95 ile birlikte gelen Paint programı görüntüleri bu formatta işler. BMP formatı 1-24 bit arasında değişen bir piksel derinliğini içerebilir. Sıkıştırma seçeneği başlangıçta bulunmamakta idi. Opsiyon olan bu sıkıştırma görüntüde detay kaybına yol açmaz, yani kayıpsız sıkıştırma yöntemlerindendir. BMP formatı alıcı bilgisayarında Paint'den başka görüntü program'ı bulunmadığı durumlarda kullanılır. 

vi. GIF
CompuServe firmasının Graphics Interchange Format (GIF) dosyaları İnternet üzerinde oldukça yaygın kullanılan bir formattır. Az sayıda renk içeren (1 ila 8 bitlik) dokümanlarda oldukça iyi sıkıştırma sağlaması, animasyonlarda zamanlama ve farklı boyutlardaki resimleri bir arada tutma desteği, saydam renk tanımlanması bu format'ı popüler yapan nedenlerden sadece bir kaçıdır. 

Ancak Photoshop gibi resim işleme programlarının çoğu GIF formatının tüm özelliklerini kullanamamaktadır. Bu nedenle bu format ile çalışırken sıklıkla başka programlara gereksinim duyulmaktadır. GIF dosyaları Bitmap, gri skala ve indekslenmiş renk sisteminde olabilmektedir. Gerçek renk desteği yoktur. GIF resimleri sıralı (interlaced) veya sırasız kaydedilebilmektedir. Sıralı GIF dosyaları yükleme esnasında satır satır gelerek resim bitiminden önce neye benzeyeceğine dair bir ipucu verirler. Saydamlık tanımlanması için GIF89a Export komutu kullanılarak saydam olacak renk belirlenebilir.

vii. PNG
PNG Portable Network Graphics formatı patentsizdir. PNG kayıpsız Wave Table sıkıştırma yöntemini kullanır. Şu anda mevcut olmayan kayıpsız gerçek renk ve saydamlık bilgilerini içeren resim kalitesini internet'e taşımayı amaçlamaktadır. PNG dosyalarılarındaki saydamlık bilgileri alfa kanalı içerisinde saklanmaktadır. Sıralı yükleme de olanaklıdır. Ayrıca sıkıştırma için değişik filtreleme algoritmaları sıkıştırma öncesi kullanılabilmektedir. 

viii. PSD
Photoshop Document (PSD) Photoshop uygulamasına özel bir formattır. PSD çok sayıda alfa kanalını, path'ı ve katmanı desteklemektedir. PSD dosyaları ikili dosya, indekslenmiş renk, gerçek renk RGB, CMYK, Lab biçimlerini destekler. Çalışma yaptığınız işlerin PSD'sini saklamayı alışkanlık haline getirmeniz, daha sonra yapıcak düzeltmelerde çok işinize yarayacaktır.

2.7 Görüntü Formatları Üzerine

i. GIF: Büyüklük ve kaydetme 

GIF formatı web üzerinde, bilgisayar grafiklerinin yollanmaları amacıyla geliştirilmiştir. GIF, 256 ve daha altındaki renkleri destekler.

Soldan sağa doğru, yatay bir hat üzerinde, benzer pikselleri tarar. Sadece renk değişikliklerini kaydeder. Bu nedenle resimde yatay alanların aynı renkle doldurulması, GIF resmin daha az dosya büyüklüğünde olmasına neden olur. 
Yatayda farklı renkte piksellerin bulunması ve noise etkisi, dosya büyüklüğünü arttırır. Aynı renkte yatay çizgilerin bulunduğu bir resim, aynı renkte dikey çizgilerin bulunduğu bir resimden (piksel büyüklükleri aynı) daha az yer kaplar. 
Tasarımınıza çok ters düşmeyecekse, degradelerin çizgi örneğindeki gibi yatay olarak uygulanması ve GIF kaydedilmesi, dosya büyüklüğünüzü azaltacaktır. 
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	277x142 piksel / 638 bayt
	277x142 piksel / 3 KB
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	277x142 piksel / 35 KB
Add Noise (Amound:50)
	277x142 piksel / 37 KB
Add Noise (Amound:50) 


GIF kaydetme:

Scannerde taradığınız resimler RGB ya da CMYK'dır. (Digital fotoğraf makinesi RGB) Bu resimleri GIF kaydetmek için modunu Indexed Color�a çevirmelisiniz. Böylece resmi oluşturan gri tonlar (RGB, Lab veya CMYK kanalları) tek bir kanalda toplanır. Resimde en fazla 8-bit�lik veri kalır, diğer renk bilgileri atılır. GIF kaydetmek için Save as ya da Export seçeneklerini kullanabilirsiniz. 
GIF89a Export seçeneğinde resmin formatı önemli değildir, export ederken size sunulan 3 ihtimalden birini seçebilirsiniz. Exact, Adaptive ve System. Resminiz Indexed Color'a çevrilip export edilir. Orijinal resminiz eski özelliklerini koruyarak kalır. 
Save as seçeneğinde ise, RGB CMYK resimlerinizi Indexed Color'a çevirmeniz gerekir. Bu çevirme sırasında size daha çok seçenek sunulur. Exact, Adaptive, System seçeneklerine ek olarak Web, Uniform seçeneklerini seçebilirsiniz. System'i ise Macintosh ya da Windows olarak belirleyebilirsiniz. 
Dither / Diffuion'u seçerseniz, resimde olmayan renklerin varmış gibi görünmeleri sağlamak için farklı renkte pikselleri oluşur.  Bu da bir renkten diğerine geçerken sert geçişlerin olmasını önler. Tek rengin geniş alanlar kapladığı resimlerde   ise none seçilmelidir, böylece düz rengin içinde farklı pikseller görmezsiniz. 

Adaptive paletini seçmeniz durumunda, 8-bit�lik resim, 24-bit kalitesine en yakın biçimde kaydedilecektir. Adaptive ile renkleri indekslerken, 8 veya daha düşük değerde bit derinliği seçebilirsiniz. Adaptive, renk kalitesini korur ancak, kullanacağınız işletim sisteminin paletine bağlı olarak paylaşılmayan renkler problemiyle karşılaşabilirsiniz. 

GIF kaydederken Web216 paletini kullanırsanız, resim, hem Macintosh hem Windows ortamında aynı şekilde görünecektir.

"File" menüsünden "Save for Web" i seçin
Açılan ekranda "optimized" bölümünde "transparency" kutusunu seçin ve "Settings" bölümünün "GIF" olduğundan emin olun.

Photoshop 6.0 ve 7.0'ın Export menüsünde GIF 89a yok, bu seçenekle çalışmalarınıza devam etmek istiyorsanız, PS 4, 5 veya 5.5 'in Import-Export klasöründe bulunan GIF89a Export.8be isimli dosyayı Photoshop'un aynı isimli klasörüne kopyalayın.

ii. GIF: Interlacing, şeffaflık ve animasyon 

GIF'i çekici kılan özellikler : Interlacing, şeffaflık ve animasyon GIF formatının desteklediği özelliklerdir. 

Interlaced, izleyicinin resmin giderek belirginleşen bir biçimde görünmesidir. Resmin yukarıdan aşağıya doğru sırasıyla önce 1, 9, 17, 25 ve ....�ci pikselleri görünürken, ardından 2, 10, 18, 26 ve ....�ci pikselleri de görünmeye başlar. Böylece  ilk kaba görüntü ile resmin ne olduğu anlaşılır. Interlaced, dosya büyüklüğünü arttırır ama önemsenmeyecek kadar.
(Aşağıdaki örneklerde fark yok gibi görünmektedir ama resmin boyutları büyüdükçe, küçük bir fark oluşur) 
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	123x190 piksel / 23 KB
Normal 
	123x190 piksel / 23 KB
Interlaced 


GIF�in ikinci avantajı, transparan (şeffaf) kayıt özelliğidir. Transparency işlemi, resmin Web sayfasında şeffaf olmasını  istediğiniz bölümlerinden, sayfanın zemin renginin (veya deseninin) görünmesini sağlar. 
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	123x190 piksel / 15 KB
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GIF'i çekici kılan bir diğer özelliği de hareketli görüntülere olanak tanımasıdır.Hareketin her bir parçası farklı bir layer'da yer alır. Bunların ardarda görünmesiyle hareket etkisi oluşur. Her Layer'ın ne kadar süre görüneceği denetlenebilir.
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	188x151 piksel / 13 KB
Normal 
	188x151 piksel / 150 KB
Animasyon 


iii. GIF’in tercih edileceği resimler:
Birkaç rengin tonlarından oluşan geniş alanları olan resimler,  logotype�lar, degrade zeminler, eğimli hatların yoğun biçimde kullanıldığı illustrasyonlar, kroki ve şematik çizimler ile karikatür benzeri, Indexed Color'a çevrilerek, GIF olarak kaydedilebilir. 

iv. GIF : Küçültmeniz gerekiyorsa 

GIF olarak kaydedilmiş resimleri küçültmeniz gerekirse... 

Az renkli ve çizgisel resimlerin gif olarak kaydedildiğinde daha iyi sonuç verdiğini biliyorsunuz. Özellikle 1-2 piksellik çizgilerden oluşmuş resimlerinizin daha küçük boyutlardaki görüntülerine ihtiyacınız olduğunda bazı sorunlar yaşayabilirsiniz. 
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Yukarıdaki resim %50 oranında küçültülünce çıkan sonucu aşağıda görüyorsunuz...
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Bunu önlemek için yapabileceğimiz birşey var ... 
Resmi RGB moda çevirin ve öyle küçültün. (Resim 1) Resim yine tam istediğimiz gibi değil ama hiç olmazsa çizgiler kaybolmadı.
Resmin özelliğine göre yeterli oranda Unsharp Mask uygulayın. Level penceresini açın. Griler siyah ya da beyaz biçimine dönüşünceye kadar ayarlama yapın. (Resim 2)
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	Resim 1
	Resim 2


v. GIF: Transparan resimde sorun giderme 

Transparan Gif yaparken dikkat etmeniz gereken ayrıntılar... 

En büyük sorun, resmin kenarında görünen, istenmeyen piksellerdir. Resim 1 deki görüntü transparan olarak hazırlandı (Resim 2) Uç kısımlardaki beyaz pikselleri farkediyor olmalısınız ... Tek renk kullandığınız transparan giflerde bunu önlemek çok kolay. Transparanlığı oluşturan bölgeyi hazırlayıp bir alfa kanalı olarak kaydettikten sonra, resminizi olmasını istediğiniz renkle doldurun (Resim 3) Gerekli işlemleri bundan sonra yapın.
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	Resim 1
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	Resim 3
	Resim 4


Resminiz çok renkliyse (Resim 5) kaydettiğiniz alfa kanalı seçili hale getirdikten sonra 1 piksel daraltın ve tekrar kaydedin. Transparan olmasını istediğiniz bölge için, daralttığınız alfa kanalını kullanının. (Resim 6) 
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	Resim 5
	Resim 6


vi. Gif/Gif89a Export ile transparan kayıt 

Transparan yapmak istediğiniz resmi önce seçmeniz gerekir. Bunun için resmin özelliğine uygun araçlar kullanarak seçiminizi tamamlayın. 
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Select /Save Selection ile bir alfa kanalı olarak kaydedin. Resmin modunu Image / Mode / Indexed Color'a çevirin. 
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File / Export / Gif89a Export penceresini açın. Selected Colors yazan kısma tıklayıp, orada kaydettiğiniz alfa kanalının görünmesini sağlayın. Okey tuşuna basın. Bir isim verip kaydetme işlemini tamamlayın.
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Sonuç aşağıda... 
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vii.  JPEG: Kaydetme ve özellikler 

Joint Photographic Expert Groups

JPEG renk geçişlerinin önemli olduğu resimlerde, renk kalitesinin ne kadar azalacağına kullanıcının karar vereceği sıkıştırma seçenekleri sunan bir formatıdır. 

Sıkıştırırken, resimdeki piksellerin renk bilgisini, piksellerin adresini kaydeder ve seçilen sıkıştırma oranını göre, benzer renkteki pikselleri aynı renge çevirir. JPEG, resimde sıkıştıracağı pikselleri bulmak için, resmi sol üst köşeden sağ alt köşeye doğru diyagonal biçimde tarar. 5/1 den 15/1 e kadar oranlarda sıkıştırma uygulanabilir.

JPEG kaydetme:

RGB resimleri JPEG kaydedebilirsiniz. Indexed Color modundaki resimler JPEG kaydedilemezler. Ayrıca resimde alfa kanallarının bulunmaması gerekir. Layer'lı dökümanlar da JPEG kaydedilemezler. 

Benzer renkteki pikseller sıkıştırma sırasında aynı renge dönüşeceği için resimin boyutlarında önemli derecede azalma olur. Bu aynı zamanda, piksellerin yok olması anlamına da geldiği için, orjinali önemli resimlerin bir yedeğinin kullanılması tavsiye edilir. Baseline Optimized seçeneği, en iyi sonucu vermektedir. Resmin kademeli oluşması için progressive seçeneği kullanılır. Netleşmenin 3, 4 ya da  5  adımda mı oluşacağını belirleyebilirsiniz. Bütün tarayıcıların desteklemediği bu seçenek daha fazla dosya büyüklüğüne neden olur. 
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JPEG'i çekici kılan özellikler:

GIF'in sadece 256 rengi desteklediği düşünülürse, milyonlarca renk içeren fotografik görüntüler için JPEG'in önemi kendiliğinden ortaya çıkar. Görüntü kalitesinin denetlenebilmesi de ayrı bir avantajdır.

viii. JPEG'in tercih edileceği resimler:

Geniş alanlar halinde tek rengin bulunmadığı, detayları fazla tüm fotografik görüntüler için kullanılabilir. 

ix. JPEG: Farklı seçeneklerin sonuçları 

RGB bir resmin farklı sıkıştırma oranlarında (Baseline Optimized)
JPEG'e çevrilmiş görüntüleri
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x. PNG : Özellikler
Web için tasarlanmış yeni bir formattır. Gif gibi 256 renkle sınırlı olmayan,  Jpeg gibi sıkıştırma oranı arttıkça kalite kayıpları oluşmayan bu format, aynı zamanda kademeli olarak görüntünün oluşması özelliğine de sahiptir. 

PNG, kayıpsız bir filtreleme ile, tüm renk bilgileri ve tüm alfa kanallarını koruyarak sıkıştırmayı gerçekleştirdiği için, eski sürüm web tarayıcıları tarafından desteklenmeyecek olmasına rağmen geleceğin formatı olarak görülmektedir. Bildiğiniz gibi, GIF 256 renkten fazlasını desteklemez, JPEG ise alfa kanallarına izin vermez.
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	GIF
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Adaptive


 PNG formatı aslen GIF için alternatif olarak ortaya çıkarılmıştır.





PNG formatı LZW sıkıştırma algoritmalarını kullanmaktadır.GIF ve JPG formatına nazaran internette paylaşılan görseller için mükemmel özellikler ve avantajlar sağlamaktadır.

PNG kalite kaybına neden olmayarak şeffaflığı destekliyor.Böylece görseller için büyük bir avantaj oluyor. PNG formatının bir diğer özelliği ise hem 8bit renk hemde 24 bit renk desteğinin bulunuyor olmasıdır.

2.8. Save for web (gif - jpg)
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Resimleri webde kullanmak için optimize etmek gerekir, yani olabilecek en küçük dosya boyutuna getirmek... Bunun için en pratik yol, save for web seçeneğini kullanmak... Resmin özelliğine göre neler yapmanız gerektiğini diğer derslerde anlatmaya çalıştım. Burada, farklı optimize biçimlerinin resimleri nasıl etkilendiğini bir arada görmeniz için farklı tip resimleri bir araya getirip, örnekler hazırladım. 

Gif
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Gif seçeneği seçerseniz, yukarıda pencere açılacaktır. Farklı seçeneklerden seçtiklerinize göre resimlerin görüntüsü aşagıdaki gibidir. 

Degrade olan (bir renkten diğerine geçiş) resimlerde gif seçeneğinin iyi sonuç vermediğini görebilirsiniz. Çizgisel resimlerde ve ekran resimlerinde ise en iyi sonucu gif'le alırsınız... Aşağıdaki örnekler, sırasıyla 64, 125 ,256 renk seçenekleriyle hazırlanmıştır. 
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Resim 1 Gif (64) 19 K
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Resim 2 Gif (128) 25 K
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Resim 3 Gif (256) 31 K

Jpeg
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Jpeg seçeneği seçerseniz, yukarıda pencere açılacaktır. Farklı seçeneklerden seçtiklerinize göre resimlerin görüntüsü aşagıdaki gibidir. 

Sıkıştırma çoksa resmin bozulma oranı doğal olarak daha fazladır. Çizgisel resimlerde bu bozulma daha belirgin görülür.

Genel olarak 50 sıkıştırma işi görecek bir sonuç verebilir.. Hem resim çok bozulmaz hem de makul bir dosya büyüklüğü elde edersiniz...
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Resim 4 Jpg (Low - 10) 11 K
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Resim 5 Jpg (Medium - 30) 16 K
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Resim 6 Jpg (High - 60) 28 K

2.9 Save for web (Dither, Matte)

Save for web seçeneğinin sunduğu diğer ayrıntılara göz atalım...

Gölge yaptığınız resimler aynı zamanda tranasparan olacaksa yaşanan bir sorun vardır. Resim:1 beyaz zemin üzerinde sorunsuz görünüyor ama Resim:2 deki gibi, zemin üzerindeki görüntüsü çok kötü...
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Resim: 1 
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Resim: 2 


 

Kullanacağımız zemin rengini, photoshopta ayrı bir layer olarak da hazırlayabilirsiniz ama bundan daha pratik bir yolu, kaydederken zemin rengini vermeniz...

Aşağıdaki örnekte matte olarak FFCC33 kullanıldı, yanda gölgenin altında aynı rengin oluştuğunu görüyorsunuz.. 
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FFCC00 olmasına karar verdiğim zemin için hazırladığım örnekler aşağıda... 
Resim:3 hazırladığım örnek... Onu beyaz zemin üzerinde kullanmayacağım için olması gereken zeminin üzerine koyuyorum.. (Resim:4)
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Resim: 3
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Resim: 4


 

Gölgede ilginçlik yapmak için denenebilecek bir şey var... Diffusion, Pattern ve Noise seçenekleri arasından noise ile yaptığım örnek...(Resim 5) Matte yine seçili..
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Resim 5

Bu tür hazırladığınız resimleri farklı zeminler üzerinde de sorunsuz olarak kullanabildiğinizi görüyorsunuz.. (Resim 6 ve resim 7)

	[image: image82.png]



Resim 6
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Resim 7 


2.10 Save for web (Quality)

Save for web seçeneğinin sunduğu başka bir ayrıntı...
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Resminizin bir bölümünü farklı oranda sıkıştırmanıza yarar. Bunun için, üstteki örnekte gördüğünüz gibi bir alfa kanalı hazırlamış olmanız gerekir. Seçtiğiniz alanı Feather verdikten sonra kayderedseniz, yumuşak bir geçiş olacaktır.
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Resim 1  11 K
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Resim 2  7 K


Resim 1'de herhangi bir seçim yapılmadan, doğrudan jpg olarak kaydedildi. (quality:60)
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Resim 1 

 Resim 2'de ise, quality'nin yanındaki bölüme tıklayın ve orada yaptığınız alfa kanalını tanıtın...
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Resim 2

3. Araç Kutusu (Toolbox)
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Profesyonel bir resim işleme programı olan Adobe Photoshop'un kullanım alanının çok geniş olduğu bir gerçektir. Ancak bizim buradaki ilgi alanımız internet ve dolayısıyla web olduğu için daha çok web sayfalarının tasarımındaki rolü ve web'deki etkisi yönüyle Photoshop'u inceleyeceğiz.

Photoshop'u kullanabilmek için öncelikle  "Tool Box" denilen "Araç Kutusu" nu çok iyi bilmemiz ve tanımamız gerekir.
Bu bölümde  öncelikle Araç Çubuğunu tanımaya çalışacağız, daha sonra Photoshop'un önemli unsurları olan, Layer (Katmanlar) 'leri, Efektleri (Layer Style), Filitreleri (Filter) tanıyacağız. Daha sonra da uygulamalara geçip basit uygulamalar olan ve web sayfalarının vazgeçilmez unsurları butonların yapımlarını, Yazı Efektlerini, reklam bannerlarının yapımı ve ImageReady yardımıyla animasyon uygulamasını, Arayüzlerin (Interface) yapılmalarını, yaptığımız arayüzlerin nasıl bölünüp web sayfalarına yerleştirileceğini linklerin nasıl verileceğini göreceğiz. Bunları yaparkende Photoshop'un nasıl kullanılacağını daha iyi öğreneceğiz.

Photoshop'u kullanmak için öncelikle yanda resmini gördüğünüz "Araç Kutusu" nu iyice öğrenmeliyiz.  Araç Kutusu, yandaki resminde görünen araçlarından başka araçları da içerir.
Gizli olan bu araçlara, yanında " [image: image91.png]


"  işareti bulunan ikonların  üzerinde mouseunuzu basılı tutup bir süre bekleterek açılacak olan yeni ikon penceresinden erişebilirsiniz.
Bunlardan birini seçerseniz Araç kutusunda ki diğer ikon ile yerini değiştirecek, kullanmaya hazır hale gelecektir. Herbirinin yanlarındaki klavye kısa yol tuşlarını da görebilirsiniz.

Şimdi "Araç Kutusu" üzerindeki ikonları sırası ile tanıyalım

Aşağıda Araç Kutusunun özelliklerini her ne kadar açıklasak da buradaki Araçların hangisine tıklarsanız tıklayın,  altta resmini gördüğünüz "Tool Options Bar" ( Araç  Seçenekleri Çubuğu ) 'ndaki ayarları ortaya çıkar. Araçlar, Ana Menünün hemen altında bulunan "Tool Options Bar" 'daki ayarları ile daha çok yetenek kazanırlar. Bunu, Photoshop'u kullanarak daha iyi anlayacaksınız.
Bu bölümde daha çok Photoshop’ta web grafikleri oluşturmak için kullanacağımız araçları inceleyeceğiz.
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"Tool Options Bar" ( Araç  Seçenekleri Çubuğu )

3.1 Rectangular Marquee Tool
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"Rectangular Marquee Tool", Kare, dikdörtgen çizmek için seçili alan oluşturur. Klavye kısa yolu gördüğünüz gibi "M" tuşudur. Kare çizmek istersek, kare şeklini seçip, klavyemizdeki Shift tuşuna basılı tutarak imajımız üzerinde mause muzu sürüklemeliyiz. Aksi halde dikdörtgen alan seçer. Elliptical Marquee Tool, Şayet Daire çizmek istersek, daire şeklini seçip yine klavyemizdeki Shift tuşuna basılı tutarak imajımız üzerinde mause muzu sürüklemeliyiz. Aksi halde elips alan seçer.Diğerleri, tek pixel olarak yatay (Single Row Marquee Tool) veya dikey (Single Column Marquee Tool) alan seçmeye yarar.
3.2 Move Tool
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"Move Tool", Seçilen bir alanı veya Layer (Katman)'ı taşımanıza yarar.Otomatik seçim özelliği olduğu gibi imajın üzeründe iken sağ tuş yaparsanız hangi Layer de olduğunuzu da belirtir. Klavuzluk görevi vardır. (V)

3.3 Lasso Tool
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"Lasso Tool", Kement Aracı denir. İmajınız üzerinde serbestçe çizerek alan seçebilirsiniz. Resmin belli noktalarını tek tek seçmenize Polygonal Lasso Tool ile yapabilirsiniz. Magnetic Lasso Tool ise kontrast ve renge duyarlıdır.
3.4 Magic Wand Tool
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"Magic Wand Tool", İmaj üzerindeki benzer renkleri seçim aracıdır. Benzer renkleri veya tonları seçebilirsiniz.
3.5 Crop Tool, Slice Tool
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"Crop Tool", Kesme Aracı denir. İmajınızdaki fazlalıkları kesmenize, fazlalıkları temizlemenize ve  imajınızı serbest olarak döndürmenize yarar. (C)
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"Slice Tool", Dilimleme Aracı, imaj üzerinde dilimler oluşturmanıza yarar. İmajınızı dilimlere bölebilirsiniz. Slice Select Tool ise dilimleri seçmemize yarar. Dilimlenmiş bir grafiği bir seferde dilim sayısınca parçalı olarak kaydedebilirsiniz.
3.6 Eyedropper Tool
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"Eyedropper Tool", resmin herhangi bir yerinden renk örneği almaya yarar. Bu aracın altında yer alan “Color Sampler Tool” ise aynı resimdeki birkaç noktadan renk kodu almaya yarar. “Ruler Tool”, grafik içersinde uzaklık ölçümü yapmak için kullanılır. “Count Tool” sayım yapmaya, “Note Tool” ise not yazmaya yarar.
3.7 Healing Brush Tool
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 “Healing Brush Tool”, özellikle fotoğraflar üzerinde manipulasyon yapmak için idealdir. Öncelikle Alt tuşu basılı iken resmin herhangi bir yerine tıklayarak örnek alınır. Daha sonta Alt tuşu bırakılarak resmin değiştirilmek istenen bölümüne tıklamalar yaparak doku yapıştırılır. Photoshop alınan örneği yapıştırılan yere eklerken erafına uyum sağlaması (kaba tabirle sırıtmaması) için uygunlaştırma da yapar. Bu araç kullanılarak örneğin sol alt köşesinde tarih yazılı olan bir fotoğraftan tarih kısmını silebiliriz.
3.8 Clone Stamp Tool
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"Clone Stamp Tool", Istampa Aracı ile İmajın bir yerine Alt tuşu ile tıkladığımızda buranın resim ve doku örneğini alır ve bu örneği istediğimiz yere tıklayarak yapıştırmamızı sağlar. Healing Pattern Stamp Tool ise hafıza-şablon (Pattern) olarak aldığımız görüntüyü kullanmaya yarar.

3.9 Pencil Tool
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"Pencil Tool", Kalem Aracıdır. İstediğiniz kalınlıkta serbest çizim yapmanızı sağlar. Brush Tool ise Fırça etkisi sağlar ve boyama yapmamıza yarar. Değişik fırça seçenekleri vardır.
3.10 History Brush Tool
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History Brush Tool", İmajın arkaplan rengini kopyalayıp imaj üzerine seçilen alanı fırça etkisiyle boyar. Art History Tool ise kullanılan seçili alandaki farklı boyama stillerine bakıp onları taklit ederek, fırça etkisiyle boyama yapar. 
3.11 Eraser Tool
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"Eraser Tool", Silme Aracı, imaj üzerinde beğenmediğiniz yerleri siler ancak silerken alttaki Layerdeki rengin vaya imajın görünmesini sağlar. Background Eraser Tool, arkaplan rengini silerek imajı transparent yapar. Magic Eraser Tool ise tek tıklama ile imajın arkaplan rengini silerek imajı tranparent yapar.

3.12 Paint Bucket Tool
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"Paint Bucket Tool", Boya Kovası ile seçili alanı, Foreground denen renk değiştirme aracındaki üstteki renk ile doldurabilirsiniz. "Gradient Tool" ise iki yada daha çok rengin birbiri arasında yumuşak geçiş yaparak seçili alanın boyanmasını sağlar.

3.13 Blur Tool
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"Blur Tool", İmaja kenarlardan dışa doğru belirsizlik hissi verir, Sharpen Tool, imajın kenarını dışa doğru keskinleştirme hissi verir, Smudge Tool, imajın rengini dağıtmak, renkleri birbirine karıştırma, leke hissi verir.
3.14 Dodge Tool
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"Dodge Tool", İmajda aydınlanmış-ışıklanmış alan sağlar, Burn Tool, İmajda koyulaşmış-kararmış alan sağlar, Spone Tool, ise imajın renk doygunluğunu azaltıp, çoğaltmaya yarar.

3.15 Type Tool
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"Type Tool", İmaj üzerinde yazı (text) yazmamızı sağlar, Photoshop'un Yazı Editörüdür (T).

3.16 Pen Tool
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“Pen Tool” diğer grafik programlarında olduğu gibi Photoshop’ta da vektörel çizim yapmaya yarayan bir araçtır. Bir cisim çizmek için öncelikle Pen Tool ile cismin köşe noktaları belirlenir. Bu işlem yapılırken ilk başlanan noktaya en son tekrar tıklamak gerekir. Daha sonra bu noktalara kavis vermek için Convert Point Tool kullanılır. Oluşturulan şekle nokta eklemek için Add Anchor Point Tool, şekilden okta silmek için ise Delete Anchor Point Tool kullanılır. Freeform Pen Tool ise serbest çizim yapmaya yarar fakat profesyonel anlamda pek sık kullanılmaz.
[image: image237.png]LAYERS.

[Normal ~ ooty 1o~

i 0 7 ok @ = [00% -




"Pen Tool", aynı zamanda etkili ve denetimli seçim alanları sağlar, yapılacak imajın düzgün kenar rotaları-yönleri çizmemize izin verir. Pen Tool ile seçim yapmak için üst menüde şekildeki gibi ortadaki seçeneğin seçili olması gerekir. Bu menüde ilk seçenek vektörel cisimler çizmek için, 3. Seçenek ise aynı cismi vektörel değil dolgu pikselleri ile çizmek için kullanılır.
3.17 Rectangle Tool
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"Rectangle Tool", en üstte Rectangular Marquee Tool bölümünde anlattığımız işlemleri yapar. Ancak bu araçın farkı Foreground denen renk değiştirme aracındaki üstteki renk ne ise uygulandığı yerde direkt o rengi kullanır ve maskeleme yapar. İsterseniz daha sonra üzerine çift tıklayarak rengi değiştirebilirsiniz. Resimde de görüldüğü gibi, köşeleri yuvarlatılmış, elips, poligonal olarak da kullanılır. Herbirinin kenarlıkları, yarıçapları "Tool Options Bar" 'dan ayarlanabilir. Line Tool, çizgi aracıdır. İstenilen kalınlıkta düz çizgiler çizer. Custum Shape Tool, Photoshop'un hazır şekiller listesini kullanmamızı sağlar.

3.18 Hand Tool
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"Hand Tool", ekrana sığmayacak şekilde büyültülen imajlarda görünmeyen yerlere ulaşmak için kullanılır.(H) Bu araç aynı zamanda Space tuşuna basılı tutarak da kullanılabilir.
3.19 Zoom Tool
[image: image240.png]¥ Timeline

(4] sl ] 5 foee [0m




 "Zoom Tool", imajın istenilen bölümüne yakınlaşmayı veya uzaklaşmayı sağlar.(Z)

3.20 Renk Paleti
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"Palet (Renk Seçim Aracı)", Foreground üstteki rengi, Background alttaki rengi belirtir. Defaunt renk (D) resimdeki gibidir. [image: image94.png]LJl



'a tıklayarak da default ayarlara geçilebilir. [image: image95.png]


'a tıklayarak alttaki ve üstteki renkleri yer değiştirebilirsiniz(X). Ancak alttaki daima Background, üstteki daima Foreground olacaktır.

4. Araç Kullanımları 
4.1 Yazı Aracı  "Type Tool" Kullanımı
Bu bölümde çok sık kullanacağımız olan Photoshop'un yazı aracı olan "Type Tool" (T) [image: image96.png]


  'u tanıyalım.
Ancak burada hemen bir hatırlatma yapmamız gerekiyor. Malesef Photoshop'un Çoklu Dil (Multi Language) desteği olmadığı için yazılarımızda Türkçe karakterler olan ı,ö,İ,ç,ş,ğ kullanamıyoruz. Bu nedenle ya Türkçe karakter setli fontları kullanmamız gerekir ki bunların bir çoğunu internet'ten temin edebiliriz, yada kullanacağımız "." nokta veya "," virgülleri başka bir Layerde oluşturup imajımızdaki  text'in üzerine veya altına taşıyıp hizalamak zorundayız. Yada Type Tool ile yazdığımız "Text" in bulunduğu Layeri, "Rasterize Layer" ile Rasterize ederek, aynı Layer'e Pencil Tool (kalem) ile nokta, virgül yada "ğ" nin inceltme işaretini elle yaparız. Ancak bu uygulamanın  yazının kalitesini biraz bozacağını da hatırlatırız. Çünkü "Rasterize Layer" ile artık yazımız "Text" özelliğini kaybetmiştir.
İmajımıza "Text" eklemek üzere, Araç Kutusundan "Type Tool" [image: image97.png]


'u seçtiğimiz   anda Layer Penceresinde kendiliğinden yeni bir Layer açılır. Yazdığımız yazı (Text) bu yeni Layer'in içinde yer alır. Çünkü her "Text" ayrı bir Layer de bulunur. Layer Penceresinde o Layer'e ait küçük Pencerenin içine de, " Hop, Bu Layerde "Text" var!.." demek ister gibi Type Tool'un simgesi " T " yerleşir.
Araç Kutusundan "Type Tool" seçildikten sonra yada Text'in bulunduğu Layer'deki küçük pencere içindeki  Type Tool " T " simgesi üzerine sol tuş ile çift tıkladığımızda "Araç Seçenekleri Çubuğunda" Type Tool (Yazı Aracı) nın komutları ve özellikleri ortaya çıkar.
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Şimdi de Araç Seçenekleri Çubuğunda bulunan Yazı Aracının Komutlarını inceleyelim; 
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Bu araç ile "Text" in türünü seçiyoruz. Başta seçili olan, normal Text aracıdır. Yanındaki ise "Text" e maskeleme için seçili alan yaratır.

[image: image100.png]



Yazılacak "Text" in soldan sağa veya yukarıdan aşağı olarak seçimini sağlar.
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Buradaki Açılır Menüden, kullanacağımız Yazı Tipini seçeriz. Sistemimizde kullandığımız fontları burada görebiliriz.
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Açılır Menüden, Kullandığımız font karakterine göre, Regular (Normal), Italik (Eğik), Bold (Koyu), Bold Italik (Koyu ve Eğik) olarak Font Style (Yazı Şekli)'i seçmemizi sağlar.  
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Açılır Menüden, Pixel cinsinden Font Size (Yazı Boyutu)'ı seçmemizi sağlar.
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Açılır Menüden, Strong (Katı), Crisp (Parlak), Smooth (Yumuşak) etki ile Anti-aliasing yöntemini seçmemizi sağlar. None seçilirse Anti-aliasing uygulanmaz. (Anti-aliasing, Text kenarlarındaki keskin hatların, kırıklıkların giderilmesi, etrafının yumuşak hatlar ile doldurulması.)
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"Text" in zemin üzerindeki pozisyonunu belirler (Solda, ortada, sağda).
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Yazımızın rengini belirlememize yarar. Üzerine tıklayınca açılan "Color Picker" den yazı rengimizi değiştirebiliriz.

[image: image107.png]b





Çeşitli eğiklik, çarpıklık gibi değişik pozisyonlara sokarak Text'e güzel görünümler sağlar.
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Yazı Karakteri ve Paragraf özellikleri gibi bütün komutların bir arada bulunduğu "Yazı Paletin" ini aktif hale getirir.
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"Text" e yapılan bütün bu ayarlamaları onaylar veya iptal eder.
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Yanda resmini gördüğünüz  "Yazı Karakteri ve Paragraf Paleti" ile yazımızın, Yazı Türünü, Karekterini, kalınlığını, yana yatıklığını, Harf büyüklüğünü (pixels cinsinden), Text yazarken ilmecin bulunduğu harfler arası mesafeyi, Yazı büyüklüğünü (% cinsinden), bulunduğu yerden yukarı veya aşağı yer değiştirmesini (pixel cinsinden), satır arası mesafesini, mevcut Text'in harfler arası mesafesini, rengini, paragraf özelliklerini,  yazı başı ve sonunun pozisyon değiştirmeleri gibi bir çok özelliğini düzenleyebiliriz.
Yazı Paletinin sağ üst köşesinde bulunan [image: image111.png]


'a tıklayarak açılan menüden, "Yazı Stili" ne ilave özellikler olan, extra koyuluk, yatıklık, harflerini tamamının büyük harf olması, script yazı türleri, alt çizgi, ortadan çizgi, harfler arası eşitliği düzenleyen "Fractional Widths" gibi seçeneklere ulaşabiliriz. 
Yine 6.0 ile beraber Text Tool'a eklenen yeni bir özellik olan, "Wrap Text" ise Text'i eğip büküp çeşitli şekillere sokarak ve bunları yatay veya dikey çekip sıkıştırarak yazıya güzel görüntüler verir.
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Layer Penceresi: Layerdeki Text'e, "Wrap Text" Uygulaması Sonrası Görünümü.

"Yazı Karakteri ve Paragraf Paleti" ile yazımızı çok kolay denetleyebiliriz.
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"Yazı Paletinde"  Extra Özellikler'e Erişebiliriz.

"Wrap Text" Seçenekleri ile Text'e güzel efektler verilebilir. 

"Wrap Text" Örnekleri:
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"Arc Upper" Efekti
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"Arc Lower" Efekti
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"Bulge" Efekti
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"Flag" Efekti
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"Wave" Efekti
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"Fish" Efekti
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"Rise" Efekti
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"Fisheye" Efekti
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"Squeeze" Efekti




Tekrar bir hatırlatma yapalım; "Text" olan Layer'e, vektörel olduğu için Filitrelerin tamamının ve ayrıca Transform > Distort ile Transform > Perspective uygulamalarının hiçbirini gerçekleştiremeyiz. Ancak bunları uygulayabilmemiz için Text'in " T " bulunduğu Layer'e sol tuş ile tıklayarak açılan menüden "Rasterize Layer" i seçerek Layer'in "Text" özelliğinin iptali için "Rasterize" etmemiz yani solid hale getirmemiz gereklidir. Aynı işi, Layer > Rasterize > Type ile de gerçekleştirebiliriz. Ancak bu işlemden sonra (Yazı Kalitesinde biraz bozulma olacaktır...), Filitreleri uygulayabiliriz. 
4.2 Free Transform
Photoshop’ta bir imajın boyutlarını değiştirmeye, eyip-bükmeye, şeklini değiştirmeye, perspektif vermeye ve yatayla yaptığı açıyı değiştirmeye, döndürmeye, yarayan "Free Transform"  sıkça kullanılan bir uygulamadır. 

Edit > Free Transform yada Edit > Transform  ile bu özelliklere ulaşabiliriz. Transform yapabilmemiz için imajımızın, transforrm yapacağımız yerini önceden seçmemiz gerekir. Şayet bu seçimi yapmazsak transform işlemi, o layerdeki bütün resimlere uygulanır. Bu hatırlatmadan sonra,  "Free Transform" u açıklamadan önce "Transform" un alt menülerini açıklayalım.

Scale:İmajın enini boyunu değiştirmeye yarar. Bu işlem yand resmi görünen ve imajın, altındaki-üstündeki yada sağındaki-solundaki küçük kutuların içe veya dışa hareket ettirilmesi ile yapılır. Köşelerdeki küçük kutular ile yapılacak değişiklik ise imajın her iki doğrultuda en ve boyunun değişimini sağlar. 
Örnek resimde imajın tam ortasında bulunan [image: image124.png]


simgesi, bölgenin merkez noktasını belirler. Photoshop'ta bir çok araçta karşımıza çıkacak olan merkez noktası simgesinin yeri değiştirilirse imajın ağırlık merkezi de değişmiş olur ve yapılacak açı değişikliklerinde yeni merkez noktası dikkate alınarak etki sağlanır. Burada konumuz olan transform işlemleri de bu yeni değişen merkez noktası esas alınarak yapılır. Bu özellik, Photoshop'un merkez noktasına [image: image125.png]


etki eden bütün araçlarında aynı sonucu verir.
Rotate: İmajı, sağa-sola döndürmeye, yatayla yaptığı açıyı değiştirmeye yarar. Tool Options Bar daki ayarlar ile bu işlemi çok düzgün br şekilde yapabilirsiniz. Örneğin tam 45° döndürmek için açı penceresine 45 yazmak yeterlidir. [image: image126.png]


Bunu gibi daha bir çok özellik tüm transformlar için Tool Options Bar da mevcuttur.
Skew: İmajın eğriliğini değiştirmeye yarar. Güzel şekiller elde edebilirsiniz.
Distort: Küçük kutucukların birbirinden bağımsız hareket ettirilmesi ile imajın biçimini değiştirir. "Render" edilmemiş "Text" lere uygulanmaz.
Perspective:  İmaja perspektif kazandırır. "Text" lere uygulanmaz.
Rotate 180°: İmajı bulunduğu konumdan 180° aksi yöne çevirir.
Rotate 90° CW: İmajı bulunduğu konumdan 90° saat yönünde çevirir.
Rotate 90° CCW: İmajı bulunduğu konumdan 90° saat yönüne ters yönde çevirir. 
Flip Horizontal: İmajın sağını soluna çevirir.
Flip Vertical: İmajı baş aşağı çevirir.
Free Transform: Scale, Rotate, Flip gibi işlemlere kolaylık sağlamak amacıyla kullanabiliriz. Bu işlemleri manuel olarak yapmamızı sağlar. (CTRL+T)
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Scale
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Rotate
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Skew
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Distort
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Perspective
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Rotate 180°
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Rotate 90° CW
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Rotate 90° CCW
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Flip Horizontal
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Flip Vertical


Yukarıdaki Orijinal İmaj'a  "Transform" Uygulama Örnekleri. 

Daha İyi Anlamak İçin, Herbirini Yukarıdaki  "Orijinal İmaj"  ile Karşılaştırın. 
 Orijinal İmaj

[image: image137.png]



5. Katmanlar (Layers)

5.1 Giriş

"Layer" leri açmak için Ana Menüden, Window > Layers (F7) yolunu kullanıyoruz. Katmanlar olarak da ifade edilen Layer'ler Photoshop gibi resim işleme programlarının en önemli unsurlarıdır. İmajımızı hazırlarken yaptımız her desenin, yazının, grafiğin birbirine karışmaması, değiştirmek istediğimizde herbirine  ayrı ayrı hükmetmemizi sağlarlar. İmajımızı hazırlarken, imaja ekleyeceğimiz her yeni parça ayrı bir katman (Layer) açılarak yapılmalıdır. Yani meydana getireceğimiz imajımız bir Üstüste Gelmiş Layer - Katmanlar - Bütünüdür.
Bunu şöyle de açıklayabiliriz;nasıl ki bir sinema filmi çekilirken film kamerası şerit halinde ve her hareketi ayrı ayrı karelere çeker de ancak film oynatıldığı zaman perdede hepsi tek bir sahne imiş gibi görünürse Layer ler de aynı böyle bir filmin kareleri gibi ayrı ayrı hazırlanır ama yapılan imaj tek bir resimmiş gibi görünür. Tabi bizim imajımızda -Katmanlarda- film kareleri gibi hareketlilik, animasyon yoktur. Bunun nedeni Photoshop'un sadece pixel tabanlı, bitmap resim işleme programı olmasıdır. Ancak pixel tabanlı imajlara da animasyon uygulaması mümkündür (Window>Animation). Layer'lerin herbirisi birbirinden bağımsızdır. Onları istediğimiz gibi yerlerini değiştirebilir, herbirine ayrı ayrı çeşitli Effect'ler (Yeni adıyla "Layer Style" ) uygulayabilir, saydamlaştırıp, altındaki layerin görünmesini sağlayabilir yada imajımızda görünmesini iptal edebiliriz.
Şimdi bu anlattıklarımızı uygulamalı  olarak görelim:
Açılan New penceresi ile yeni açılacağımız dökümanımızın hangi özelliklerde olacağını belirliyoruz.
Bu Pencereyi (aşağıdaki şekil) biraz açıklayalım, Name kısmını dökümanınıza (imajınıza) bir ad vermek için kullanabilirsiniz. Image Size Bölümünde, imajımızın genişliğinin (Width), yüksekliğinin (Height) pixel cinsinden ne olacağını yazacağız. Bütün resim işleme programları gibi Photoshopta da ölçü birimi pixel olduğundan bu kısmın pixels olarak kalması çok önemlidir. Resolution penceresi ise imajımızın pixels/inch olarak çözünürlüğünü belirliyoruz. Bu sayfalarda Photoshop ile web sayfalarımızda kullanılacak imajları düzenleyeceğimizi var sayarak ve imajımızı web de yayınlayacağımızı düşünerek monitör çözünürlükleri de 72 pixel olduğundan Resolution bölümünün mutlaka 72 pixels/inch olması gerekiyor. Yani monitör de 1 inc (2,54 cm) lik bir alanda de 72 pixel görünecektir. Color Mode Kısmı, yine monitörler açısından ekran görüntü renkleri olan RGB Color olarak kalacaktır. Contents Bölümünü imajımızın arkaplan rengini belirleyeceğimiz bölümdür.Yani imajımız hangi renk üzerine oturacaktır? Bu bölümde White, Background,Transparant olarak 3 seçenek görüyoruz. White: Seçilirse arka plan renginin Beyaz olur, Background: Araçlar Kutusunu açıklarken sözü edilen Renk Seçim aracında (Palet'te) alttaki rengi ifade eder. 
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Yan taraftaki resimde görüleceği üzere, Background (Alttaki Renk) Mavi, Foreground (Üstteki Renk) Kırmızı’dır. Resimdeki Mavi’nin olduğu yere hangi rengi verip, "Contents" bölümünde, Background seçeneğini işaretlersek imajımızın arka plan rengi o renk olur. İsterseniz, [image: image139.png]


'a tıklayarak renkleri yer değiştirebilir (Klavyedeki X Tuşu) yada  [image: image140.png]LJl



'a tıklayarak da default ayarlara (Background Beyaz, Foreground Siyah) geçebilirsiniz. (Klavyedeki D Tuşu)

[image: image243.png]Toeen



Renk Seçim Aracı (Palet) 
Transparent: Seçilirse, imajımızın arka plan rengi olmayacak, imaj penceresi zemini yandaki resimdeki gibi görünecektir.Transparent olan imajlar, yerleşecekleri web sayfalarının arka plan rengi (<body bgcolor="#FFFFFF">) ne olursa olsun o renk ile uyumlu olacaklardır. 
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New Penceresindeki ilgili yerleri düzenledikten sonra OK Tuşuna basıp nihayet yeni imajımızı açıyoruz ve devam ediyoruz. Şayet Layer sekmesi görünmüyorsa Ana Menüden, Window > Layers ile Layerlerimizi aktif hale getiriyoruz. İlk açılışta Layer Penceresi görüntüsü yandaki gibidir. 
Şimdi imajımıza yeni bir Layer ekleyerek, Layer Penceremizi biraz daha iyi tanımaya çalışalım

Ana Menüden Layer > New > Layer ile yeni bir Layer açalım. (Shft+Ctrl+N). 
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*Yeni Layer’i, ayrıca Layer Penceresinin altında bulunan [image: image142.png]


'a tıklayarak da açabiliriz.
Fill: Layer’ımızı saydamlaştırmak, şeffaflaştırıp, altındaki layer'ın görünmesini sağlamak için % değeridir. 100% değeri Layer ımızın mat, saydamlaşmamış halidir. Bu değeri % cinsinden düşürdükçe saydamlaşarak alttaki Layer ın görüntüsünü açar. İki Layer beraber görünürler.
Opacity: Fill ile aynı görevi görür ancak üzerine katman efekti uygulanmış (örneğin Color Overlay ile üzerine yeni bir renk döşenmiş) bir katmanın Fill değerini düşürmek onu şeffaflaştırmaz çünkü üzerine başka bir renk overlay edilmiştir. Katman efekti ile birlikte şeffaflık vermek için Opacity kullanılır. 

5.2 Layers Penceresi
 [image: image245.png]¥ Timeline:
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Layer penceremiz daha yakından tanımak için yandaki resmi inceleyelim:
1-Göz (Indicates layer visibility): Layeri görmemizi sağlar, şayet mouse ile gözün üzerine tıklayıp kapatırsak o layer'i imajımızda göremeyiz. Açık olan göz, Layer'i gösterir.
2-Zincir (Link Layers): İki ya da daha fazla layer seçili ise onları birbirine bağlamaya yarar. Bağlanan katmanlar birlikte hareket ederler.
3-Efekt Uygulaması (Add a layer style): Layer’ımıza çeşitli efektler uygulamamızı sağlar. Tıkladıktan sonra açılan pencereden bir efect seçersek seçtiğimiz efektin işaretlendiği Layer Style penceresini açar.
4-Maskeleme Aracı (Add a mask): Layer e mask ekler.
5- Renkleri ve Tonlarını değiştirme Aracı (Create new fill or adjustment layer): Mecut renklerimizde çok güzel değişiklikler yapmamızı sağlayan özellikleri çalıştırır. 
6-Yeni set oluşturma Aracı (Create new set): Katmanları gruplamak için katman klasörü oluşturur.
7-Yeni Layer Oluşturma Aracı (Create a new layer): İmajımıza yeni bir layer ekler.
8-Layer'i silme Aracı (Delete layer): İptal etmek istediğimiz için işaretlediğimiz layer i siler.
9-Opacity: Yukarıda anlatılan Matlık değeri (efektlerle birlikte). 

10-Fill: Katman matlığı (doluluk/şeffaflık değeri)

11-Mode: Altındaki layer’lar ile çalışma tarzını buradaki listeden seçebiliriz.
12-Layer'deki transparent pixelleri kilitler.
13-Layer'in üzerinde herhangi bir boyama işlemini engeller. 
14-Layer sağ-sol, aşağı-yukarı hareketini kilitleyerek engeler.
15-Layer'i bütün müdahalelere karşı kilitler.

16-Layer seçenekleri: Buradan yeni Layer oluşturabilir, seçilen Layer in kopyasını çıkarabilir, Layer i silebilir, Layer özelliklerini görebilir, Layer Style de Blending Seçeneklerine ulaşabilir, Layer leri birbirleri ile birleştirebilirsiniz.
5.3 Katman Uygulamaları
 Bir kaç küçük uygulama yaparak Layer penceresini biraz daha yakından tanıyalım; 
Daha önceden gördüğümüz gibi, şayet kapalı ise, Ana Menüden, Window > Layers ile Layer penceresini açalım.
Yeni bir imaj başlamak için Ana Menüden File > New  ' seçiyoruz, ya da  Ctrl+N klavye kısa yolunu kullanarak dökümanımızı açıyoruz. Önceden gördüğümüz  New Penceresi karşımıza geliyor. Ayarlarımızı yapalım, Name bölümüne bir isim yazabilir veya boş bırakabilirsiniz. Nasılsa kayıt sırasında bir isim vereceksiniz! Biz yine "Photoshop-Layers" yazıyoruz.
Width bölümüne 250 yazıyoruz, Height bölümüne de 250 yazıyoruz pixels ler olduğu gibi kalıyor. Resulation 72 pixels/inch, Mode: RGB Color, Contents de ise White'ı işaretliyoruz. Bu verdiğimiz değerlere göre imajımız, 250 x 250 Pixels ölçüsünde yani Kare şeklinde, 72 pixels/inch çözünürlükte, RGB (Red:Kırmızı, Green:Yeşil, Blue:Mavi'dir. Monitörler için Ana Renkler modu) Renk modunda ve beyaz zeminli olacaktır. OK deyip imajımızı açıyoruz. Çizimlerimizi daha düzgün yapmak için, mesafelerini ayarlamak içinimajımızın etrafına  Ruler (Cetvel)'i açmamızda fayda vardır (View > Show Rulers : Ctrl+R). 
İmajımızı Açıyoruz. (Ruler-Cetvel Görünüyor.) [İmaj Penceresi]
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Anlatılanlara Göre Layer Penceremizdeki İşlemler:
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 Swatches Penceresinden Renklerimizi Seçebiliriz.
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"Layer Order"  Yaparken Layer Penceremizdeki İşlemler:
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İmajımızı çizmeye başlayalım; Öncelikle Layer Penceresinden [image: image147.png]


tuşuna basarak yada Layer > New > Layer ile yeni bir Layer açalım. (Shft+Ctrl+N). Bu yeni layerimızın üzerine sağ tuş ile tıklayarak açılan pencereden Layer Properties i seçip Name kısmına, "Daire" yazalım. Böylece Yeni Layer ımıza "Daire" adını vermiş olduk.
Daha sonra Tool Box dan Marquee Tool dan  Elliptical Marquee Tool u [image: image148.png]


seçerek "Daire" Layer ımızın içine istediğimiz boyutta bir daire çizelim. Düzgün bir daire çizmek için bir elimiz de mause ile daireyi çizerken diğer elimizi de klavyemizde shift tuşuna basılı tutalım (Çizim Bitene Kadar!). Eğer Shift tuşunu basılı tutmazsak çizimimizin elips olacağını, tam daire yapmak için çok uğraşacağımızı hatırlatırız. Şimdi çizdiğimiz bu daireyi boyamak için Swatches penceresinden bir renk seçelim. [image: image149.png]


(Window > Show Swatches) Biz burada Kırmızı'yı seçtik (RGD Red). Renk Değişim Aracında (Palet'te) üstteki renk "Foreground" Kırmızı oldu. Tekrar Tool Box dan bu defa Paint Bucket Tool'u [image: image150.png]


seçerek dairemizi seçtiğimiz kırmızıya boyamak için seçili alanın üzerine bir kere tıklıyoruz. İşte bu kadar. Artık "Daire" isimli Layer ımız da Kırmızı renkte bir Dairemiz var.
Tekrar Layer Penceremize gidip, [image: image151.png]


basarak ikinci bir Layer açalım. Bu Layer ımıza da  yukarıda bahsettiğimiz şekilde " Kare" adını verelim. Artık "Kare" adında ikinci bir Layer ımız oldu. "Kare" Layer ımız seçili iken (Mavi Renk) ( [image: image152.png]


Göz ve Fırça açık - görünür olacak), tekrar Tool Box dan Marquee Tool aracına gidip bu defa Rectangular Marquee Tool u [image: image153.png]


seçerek yine Shift tuşunu basılı tutarak istediğimiz büyüklükte bir kare çizelim. Eğer Shift tuşunu basılı tutmazsak çizimimizin dikdörtgen olacağını, tam kare yapmak için çok uğraşacağımızı bir kez daha hatırlatırız. Karemizi boyamak için tekrar Swatches penceresinden bir renk seçelim. [image: image154.png]


Bu defa Lacivert'i seçtik(RGB Blue). Bu defa Renk Değişim Aracında (Palet'te) üstteki renk "Foreground" Lacivert oldu.Tekrar Tool Box'dan Paint Bucket Tool'u [image: image155.png]


seçip, imajımızda seçili olan karemizin içine tıklıyoruz. İkinci Layer'imiz olan "Kare" isimli Layer ımız da da Lacivert renkte bir Karemiz oldu.
Layer'leri daha iyi tanımak ve mantığını anlamak için "Kare" isimli Layer'imizdeki Kareyi Dairemizin üzerine sürükleyerek taşımak için Tool Box 'tan Move Tool aracını seçip [image: image156.png]


, Karenin üzerine basılı tutarak Dairenin üzerine sürükleyerek taşıyoruz. Layer Penceresine dikkat ederek, gördüğünüz gibi İmajımızda, Layer sırasına göre Layer Penceresindeki alttaki "Daire" Layer'ında olan daire altta, üstteki "Kare" Layer'ında olan kare üstte duruyor. Arzu edersek bunların yerini değiştirmemiz de mümkündür. Yani Daireyi üste, Kareyi alta alabiliriz. Şöyleki; Layer penceresine gidelim, "Daire" Layer'ına tıklayalım, mause'umuz üzerinde iken basılı tutarak üstteki "Kare" Layarının üzerine sürükleyelim (Layer Order), artık Daire, Karenin üzerinde yer aldı. Layer leri yer değiştirmek için bunun tersini de, üssteki layer'i sürükleyerek alttaki layer'in altına taşımak suretiyle de yapabiliriz. Yani Layer ler birbirlerinin altına ve üstüne sürüklemek suretiyle taşınabilirler, böylece içlerinde çizili olan resimlerde birbirlerinin altında ve üstünde olmak üzere yer değiştirmiş olurlar (Layer Order).
Yaptığımız imajımızı PSD Formatında kaydedelim ki tekrara açtığımızda Layer'lerimiz kaybolmamış -kapatılmamış- olsun. Aksi halde bütün Layer ler birleşecek, imajı açtığımızda Layer Penceresinde sadece tek bir "Background" 'da Kırmızı bir daire resmi ve Lacivert bir kare resmi görünecek, Daire ve Kare isimli 2 adet Layerler görünmeyecektir.


Palette (Renk Seçim Aracı),  Üst renkleri (Foreground)seçiyoruz.

[image: image157.png]



İmajımızı PSD Formatında Kaydettik.

 [image: image158.png]



Üçüncü "Dikdörtgen" Layer'ımızı yaptık.
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Move Tool ile  Tool Options Bar'da "Auto Select Layer"'i Seçmek.

(Bu seçenek seçildiğinde, Move Tool ile herhangi bir cisme tıklandığında otomatik olarak o cismin bulunduğu katman seçili hale gelir. Bu bazı durumlarda kolaylık sağlarken bazı durumlarda da istenmeyen durumlara sebep olabilir. Gerektiğinde kullanılmalıdır.)
İmajımızı PSD Formatında kaydettikten sonra, Layer özelliklerini biraz daha inceleyelim.  Layer Penceresinden [image: image160.png]


tuşuna basarak yada Layer > New > Layer ile yeni bir Layer açalım. (Shft+Ctrl+N).
Layer Properties'de Name kısmına, "Dikdörtgen" yazalım. Layerımız seçili iken (Mavi Renk) ( [image: image161.png]


Göz ve Fırça açık - görünür olacak), tekrar Tool Box dan Marquee Tool aracına gidip  Rectangular Marquee Tool'u [image: image162.png]


seçerek - bu defa Shift tuşuna basılı tutmadan - istediğimiz büyüklükte bir Dikdörtgen çizelim. Eğer çizim sırasında Shift tuşunu basılı tutarsak çizimimizin Kare olacağını bir kez daha hatırlatalım. Dikdörtgenimizi boyamak için tekrar Swatches penceresinden bir renk seçelim. [image: image163.png]


Bu defa Yeşil'i seçtik (RGB Green). Bu defa Renk Değişim Aracında üstteki renk "Foreground" Yeşil oldu. Tekrar Tool Box'dan Paint Bucket Tool'u [image: image164.png]


seçip, imajımızda seçili olan dikdörtgenin içine tıklıyoruz. Layer Penceremizde Üçüncü Layer'imiz olan "Dikdörtgen" isimli Layer ımız da da Yeşil renkte bir Dikdörtgenimiz oldu. 
Önceden gördüğümüz gibi imajın içinde Layerleri -Layerlerin içindeki resimleri- sürükleyerek taşımak için Tool Box 'tan Move Tool aracını [image: image165.png]


, seçip sürükleyerek taşıyorduk. Move Tool Aracının özelliklerinden bahsedersek, bu aracı seçtiğimizde, Tool Options Bar'a dikkat edersek, "Auto Select Layer" kutucuğunu görürsünüz. Şayet bu kutucuk işaretli değilse, Move Tool Aracını imajımızın içindeki herhangi bir resmin üzerinde sağ tuş ile tıklarsak o resmin hani Layer de olduğu en üstte olmak üzere altındaki bütün Layerlerin listesini gösterir. Buradan Layer Penceresindeki istediğiz Layer'i seçebiliriz. Ancak bu kutucuk işaretli ise Move Tool Aracını hangi resim üzerine tıklarsak, Layer Penceresinde o resmin Layer'ini otomatik olarak seçer.

Layer Penceresinde bulunan göz şekline tıklarsanız, "Göz" ikonu kaybolur ve o layere ait resim imajımız da görünmez. Resmi tekrar görmek için "Gözün" kaybolduğu ikonuna tekrar tıklayıp "Göz" ikonunu aktif hale getirmemiz gereklidir. Yani istemediğimiz layerleri imajdan silip, sonradan pişman olmaktansa,  "Göz" ikonu ile kapatıp, tekrar açabiliriz.

Layer Penceremizin Boyutlarını sağ alt köşesinde bulunan [image: image166.png]


noktasından tutup çekerek -yandaki şekildeki gibi- büyültüp, küçültebiliriz.

İmajımızı, tekrar PSD Formatında kaydedelim ( File > Save ). 

[image: image167.png]Layers.

Ferma—|

Duplate Laye.
Lk TR Dofte Layer
B Newiwerset

Layer Propertes
Blending Options.

Merge Down
Merge Visble
Flaten Image:

)
[ e~ L L

.

Palette Options.




Layer'leri Kontrol Penceresi. (1)
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Zincir ile Layerleri Link haline getiriyoruz.
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Zincir ile işaretlenmiş Layer'lerin Kontrol Penceresi. (2)
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Palette Options ile Layer'in iç pencerelerinin büyüklüklerini ayarlayabiliriz veya pencereleri "None" ile kapatabiliriz. 

İmajımızı PSD Formatında kaydettikten sonra, Layer Penceremizde üst köşede bulunan [image: image172.png]


'un özelliklerini de biraz daha inceleyelim. 
Bu yan ok tuşuna basınca, yandaki resimde görüldüğü gibi Layer'leri Kontrol Penceresi açılır. Bunları yukarıdan aşağıya doğru sırası ile inceleyelim; 
New Layer: Yeni bir Layer oluşturmaya yarar.
Duplicate Layer: İşaretleyerek seçtiğimiz (mavi renk olan ve önünde fırça resmi bulunan ) Layer'in bir kopyasını çıkarıp yeni bir layer olarak Layer Penceresine yerleştirir.
Delete Layer: İşaretli Layer'i siler.
New Layer Set: Yeni bir Layer Set oluşturur.
Layer Properties: İşaretli Layer'in Özelliklerini açar.(Layer'e yeni bir ad verebiliriz,adını ve rengini değiştirebiliriz.)
Blending Options: İleride göreceğimiz efektleri düzenlememize yarayan ve çok sık kullanacağımız "Layer Style" Penceresini açar. ("Harmanlama-Karışım Seçenekleri"  penceresi de denebilir).
Merge Down: Layer bir altındaki Layer ile birleşip tek bir Layer yapar. 
Merge Visible: Layer Penceresinde Göz ikonlarının yanlarındaki boş kutucuklara tıklarsak bu kutucuklarda [image: image173.png]


 zincir şekli yer alır. Bunu anlamı; [image: image174.png]


zincir ile işaretlenmiş Layerler beraber hareket etmek zorundadırlar (Constrain).Yani birbirleri ile alakalı olmuşlardır. Buna "Link" oluşturma da denir. Hatırlarsanız, Layerler, yanlarındaki Göz ikonlarını kapattığımızda imajımızdan kayboluyorlardı. Yani "Görünmez" oluyorlardı. [image: image175.png]


zincir ile işaretlenmiş herhangi bir Layerleri görünmez yaparsak (Göz İkonunu kapatarak), "Merge Visible"  seçeneği ile sadece görünen Layerleri birleştirip tek bir Layer yapar, görünmeyen Layeri yalnız bırakır.
Flatten Image: Bütün Layerleri birleştirip kapatır. İmajımızı bu şekilde kaydedip kapatırsak, bir daha açtığımızda Layerlerimizi göremeyiz.
Palette Options: Layerlerin içlerindeki küçük pencerelerin [image: image176.png]


(Paletlerin) büyüklük ve küçüklüklerini ayarlamamızı sağlar veya pencereleri yok edip Layer Penceresinde sadece Layer adlarını gösterir.
Eğer Layerleri  [image: image177.png]


zincir ile işaretleyip, tekrar [image: image178.png]


'u tıklarsak bu defa Layer Kontrol Penceresinin yeni özellikleri ortaya çıkar (2).
Şimdi buradaki yenilikleri inceleyelim;
New Set From Linked: [image: image179.png]


zincir ile işaretleyip Link oluşturduğumuz Layerlere yeni bir "Set" oluşturur.
Lock All Linked Layer: Link oluşturduğumuz bütün Layerleri müdahalelere karşı kilitler. Kilitli Layerlere işlem yapamayız.
Merge Linked: Sadece [image: image180.png]


zincir ile işaretleyerek Link oluşturduğumuz Layerleri birleştirip tek bir Layer yapar.

Layer Penceresine herhangi bir Layer'e Sağ tuş ile tıklarsak yeni özellikleri açılır. Gerçi bu özellikleri ileride Maskeleme, Type Tool yazı aracı kullanımı ve imaja filitrelerin uygulanmasında daha geniş olarak açıklayacağız. Ancak Layer penceremizi tanımak açısından burada da kısaca gözgezdirmek zorundayız. Yandaki resimde aktif olanlardan yukarıda bahsetmiştik, şimdi sadece aktif olmayan pencereleri açıklarsak;
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Enable Layer Mask: Layer'e uyguladığımız maskelemeyi aktif hale getirir.
Rasterize Layer: Photoshop'un Yazı Aracı olan Type Tool [image: image181.png]


ile bir yazı (Text) yazdığımızda bu yazıya direkt olarak filitreleri uygulayamayız. Bunun gibi Photoshop'un Türkçe karakterleri tanımama özelliği olduğundan yazılarımızda Türkçe karakter kullanamıyoruz. Örneğin küçük harf ile " ı " yazamıyoruz. Bu nedenle önce küçük harf ile " i " yazıyoruz. Daha sonra Layeri "Rasterize Layer" ile rasterize ederek, yazımızı "Text - yazı" özelliğinden çıkarıp, " i " harfini üzerindeki "nokta (.)" işaretini [image: image182.png]


Marquee Regtanguar ile işaretleyip seçerek  siliyoruz. İşte artık küçük bir " ı " harfimiz oldu.
Copy Layer Style: Layer üzerine evvelce uygulanmış Efektleri kopyalar. (Photoshop'un eski sürümlerindeki "Efektler" adının 6.0 sürümü ile "Layer Style" olarak değiştiğinden evvelce bahsetmiştik.)
Paste Layer Style: Kopyalanmış Efektleri seçilen Layer'e yapıştırır.
Paste Layer Style to Linked: [image: image183.png]


zincir ile link verilmiş olan tüm Layerlere kopyalanmış efektleri yapıştırır. Böylelikle aynı efekti her Layer'e vermek için tek tek uğraşmazsınız.
Clear Layer Style: Layerdeki efekti siler.
5.4 Katman Efektleri
[image: image247.png]


Efektlerin, Ana Menüden, Layer > Layer Style alt menüsünü açarak "Blending Options" adı altında sıralandığını görebilirsiniz. Efektleri incelemeye başlamadan önce iki ayrı efekt çeşidinin olduğunu bilmemiz gerekir. Bunlardan birisi, "Blending Options" dan ulaşılan ve Drop Shadow (Gölge Vermek), Inner Shadow (İçe Gölge), Outher Glow (Dışa Parlaklık), Inner Glow (İçe Parlaklık), Bevel end Emboss (Eğim - şev ve Kabartma Etkileri), Satin (Saten etkisi), Color Overlay (Renk verme), Gradient Overlay(Eğim verme), Pattern Overlay (Desen-model verme), Stroke ( Hat verme) olarak adlandırılan efektlerdir. Bu efektlere, yukarıda belirttiğimiz gibi "Blending Options" altından ulaşabileceğimiz gibi daha kolay yolu olan, Layer Penceresindeki Layer'e çift tıklayarak yada Layer Penceresinin altındaki Effect  simgesine ( [image: image184.png]


) tıklayarak açılan "Layer Style Penceresi" nden ulaşabiliriz. Diğeri ise hem Layer Penceremizin üst tarafında bulunan Açılır Menüden hemde Layer Style Penceresinde ki "Blend Mod" dan ulaşabileceğimiz Layer Efektleridir. 
[image: image185.png]


Bu efektler Photoshop'un birçok komutunda karşımıza çıkacaklar. Ancak her yerde aynı özellikleri taşıdığından sadece burada açıklayacağız. 

Hatırlarsanız, meydana getirdiğimiz imajımızın üst üste gelmiş bir katmanlar bütünü olduğundan bahsetmiştik. Katmanları alta ve üste sürükleyerek yerlerini değiştirebiliyor, şeffaflıklarını ayarlayabiliyorduk (Opacity). Bu nedenle, Layerleri asetat kağıtlara da benzetebiliriz. "Opacity Değerini" düşürdükçe (Şeffaflaştırdıkça) geçirgenliği artıyor ve bir alttaki resmin görüntüsü ortaya çıkıyordu.
Bu hatırlatmadan sonra, öncelikle, yan tarafta resmini gördüğünüz Layer Efektlerini tanıyalım;
Normal: Sıradan asetat katmanıdır. "Opacity" değeri % 0 iken tam geçirgen, % 100 iken geçirgen değildir.
Dissolve: Erime, dağılma etkisi verir. Dağınık, kirli, pürüzlü yüzeylerin yapımında bu efekt çok etkilidir.
Multiply: Siyah rengin hakim olduğu koyu bir görüntü elde ederek, iki Layer'i birbirine kombine eder.
Screen: Yine iki Layer'i kombine ederek bu defa açık renklerin hakim olduğu bir görüntü elde eder.
Overlay: "Multipy" ve "Screen" efektlerinin tam orta noktasını bulur.
Soft Light: Hafif bir spot ışığı etkisi verir. Etki rengi koyu ise "Multipy", açık ise "Screen" uygular. İmajın kontrastını yükseltir.
Hard Light: "Soft Light'ın daha şiddetlisidir.
Color Dodge: Uygulanan renk, uygulayıcının renk değerlerine göre parlaklaşır.
Color Burn: Color Dodge'nin tam karşıtıdır.
Darken: Birbirleriyle etkileşim yapan renklerden koyu olanı baskınlaştırır.
Lighten:  Darken'in tam karşıtıdır.
Difference: Etkileşen renklerden açık tonda olanı bularak diğer renkten RGB değerini çıkarır.
Exclusion: Difference ile aynı mantıkta çalışmasına rağmen daha yumuşak sonuç verir.
Hue: Etki eden ile etki edilen renk değerleri kombine edilir.
Saturation: Rengin şiddetidir. Etki eden ile edilenin kombinasyonu neticesi renk elde eder.
Color: Rengi farklı şeffaf bir Layer in diğer Layer'e etkimesini sağlar.
Luminosity: Rengin parlaklığıdır. 

Şimdi de Layer Penceremizde efekt vermek istediğimiz Layerin ortasına çift tıklayarak, "Layer Style" penceresini açıp, yandaki resimde sadece ilgili kısmı görünen ve "Layer Style - Blending Options" dan ulaşacağımız Efektleri inceleyelim;
[image: image248.png]



Drop Shadow: Herhangi bir Layer' de olan ve imaj penceremizin içine çizdiğimiz  şekle gölge verir. İçindeki ayarları:
Structure:
*Blend Mode: Yukarıda açıklanmıştı (Normal, Dissolve, vs.).
*Opacity: Geçirgenlik, şeffaflık oranıdır. Default (Varsayılan-Standart) değeri %75 dir.
*Angle: Açı'dır. Işık kaynağı ile cisim arasındaki sanal doğrunun yatayla yaptığı açıyı ifade eder. Default değer 120° dir.
*Use Global Light: "Genel ışık değerini kullan." Bunu seçersek, resimdeki gölgeleme yapan tüm ışık değeri ile genel ışık değerini kullanırız. Bunu değiştirirseniz tüm Layerlerdeki ışık değerleri ve açıları değişecektir.
*Distance:  Resim ile gölgenin düştüğü zemin arasındaki pixel cinsinden uzaklığı belirler. Default değeri 5' dir.
*Spread: Gölgeyi yaymak için kullanılan % değeridir. Yüzde değeri çoğaldıkçe gölgenin bulanıklığı azalır. Default değeri 0' dır.
*Size: Gölgenin pixel cinsinden ebatalarını belirler.
Quality:
*Contour:Photoshop'un bünyesindeki desenlerle veya bizim "Define Pattern" ile kaydettiğimiz desenleri, gölgenin dış hatlarına uygular.
*Anti-aliased:Tek pixellik çizgilerin açı kazandıklarında oluşan rahatsız edici çıkıntılarının daha açık bir renkle yumuşatılması ve boşlukların daha koyu bir renkle doldurulması işlemi olan Anti-Alias'ın gölgeye uygulanmasını sağlar. 
*Noise: Gölgeye % cinsinden rastgele pixeller ekler. 
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Layer Penceresindeki "Göz"leri kapatarak, verdiğimiz Efektleri imajımızdan kaldırabiliriz.

Efektlere devam edelim, buradaki efektlerin özelliklerinin bir çoğu "Drop Shadow" ile aynı olduğundan sadece farklı olan ayarlarını inceleyeceğiz;
Inner Shadow: İçe gölge verme efektidir. Resmin daha uzakta gömülü gibi görünmesini sağlar. Farklı olan, Choke: Gölgeyi içe doğru yayarak imajı boğar.
Outher Glow: Dışa parlaklık efektidir. Resmin etrafına neon ışıkları ile aydınlanma kazandırır. Biz yine farklı olanları inceleyelim,
Structure: 
Bu bölümde işaretli kutucuk içine tıklarsanız açılacak olan "Color Picker" den efekte vereceğiniz rengi seçebilirsiniz. Hemen yanındaki "Gradient" ( Eğim ) penceresini açarsanız, buradan hazır şablonları kullanabileceğiniz gibi isterseniz kendinizde şablon hazırlayarak bu efekte uygulayabilirsiniz.  
Elements: 
Technique: Softer: Parlaklığa yumuşak bir etki verir. Precies: Tam parlaklık sağlar. 
Inner Glow: İçe Parlaklık efektidir. Neon ışıkları türündeki efekti cismin içine uygular. 
Elements: 
Source: Parlaklığı, Center: Ortadan dışa doğru, Edge: Kenardan ortaya doğru verir. 
Quality: 
Range: Parlaklığın menzilini % cinsinden belirler. Default değeri % 50 dir. Yüzde değeri küçüldükçe içe, büyüdükçe dışa doğru mesafesini ayarlar. 
Jitter: Parlaklığın imaj üzerindeki stresini % cinsinden belirler.
Bevel and Emboss:  Eğim-şev, kabartma efektidir. Aydınlatma ve karartma ile imajın kabarık, zemine gömülü veya şişkin görünmesini sağlar.
Structure:  
Style: Burada açılır menüde 5 tane efekt vardır. Outher Bevel: Dışa eğim-şev verir. Inner Bevel: İçe eğim verir. Emboss: Kabartma etkisi yapar. 
Pillow Emboss: Zeminin alt yüzeyine kabartma efekti vererek imajın zemine gömülmesi etkisini yaratır. Stroke Emboss: İmaj kenarlarına kabartma etkisi verir. Default ayarı, Inner Bevel'dir.
Technique:Buradaki açılır menüde de üç adet efekt vardır. Smooth:Düzgün, yumuşak etki yapar. Chisel Hard: Kabartmaya sert yontma etkisi yapar. Chisel Soft: Kabartmaya yumuşak yontma etkisi yapar. Default ayarı, Smooth'dur.
Depth: Efektin derinliğini yüzde cinsinden belirler. Default ayarı, % 100 'dür.
Direction: Burada yanındaki radyo düğmeleri ile seçilen iki değer vardır. "Up", Işığın sol üstten, "Down", ışığın sağ alttan gelmesini sağlar.Default ayarı, "Up" tır.
Size: Efekt etkisinin yüzde cinsinden boyutudur. Default ayarı, % 5' dir.
 
Shading: 
Bu bölüm, efekte yapılan gölgeleme ayarları bölümüdür. Gloss Contour: Buradaki hazır şablonlar ile veya kendiniz şablon ekleyerek efektin dış hatlarına parlaklık ekleyebilirsiniz.
Highlight Mode - Shadow Mode: Işık ve gölge tarzlarını, daha önce anlattığımız Layer Efektleri bölümündeki ayarlardır. (Normal, Dissolve, vd.) Default ayarları, Highlight Mode'da Beyaz renk ve Screen, Shadow Mode'da Siyah renk ve Multiply'dir. Opacity değerleri her ikisinde de % 75 'dir.
Dikkat ederseniz, "Layer Style Penceresi"nde, Bevel and Emboss efekti altında bulunan "Contour" ve ""Texture" sekmelerini göreceksiniz. Buradan, "Contour" sekmesinden ayrıca efektin dış hatlarına verilen efekt değerlerini ayarlayabilirsiniz. "Texture" sekmesinden de hazır şablonları kullanarak veya kendiniz "Define Pattern" ile oluşturduğunuz şablonlarınız ile imajın üstüne desenler ekleyebilirsiniz.
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İmajımıza "Texture" ile hazır şablonları kullanarak, iki farklı desen ekledik.
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Üstteki küçük dökümanı "Define Pattern" ile hafızaya alarak, altındaki büyük dökümanımıza "Fill" ile döşedik.

Satin: İmaja verdiği efekt ile saten etkisi yaratır. Default ayarları, Blend Mode: Multiply, Opacity %50, Angel 19°, Distance:11px, Size:14 px'dir.
Color Overlay: İmaja renk kaplama efektidir. Blend Mode'un yanındaki renk kutusuna tıklayarak, açılan Color Picker'den seçilen renk ile Blend Mode daki seçime göre renk efekti ekler.
Gradient Overlay: İki yada daha çok rengin birbiri arasından yumuşak geçiş yaparak imajı boyar. Default ayarları resimdeki gibidir.
Pattern Overlay: Hazır Şablonları Kullanarak veya Define Pattern ile kendi yarattığınız şablonlardan oluşan desenler ile imaja kaplama yapar.
Stroke:
İmaj altında etkisi ile dış kenarlarına çerçeve ekler. Position: Çerçevenin pozisyonunu belirler, çerçeveyi, Outside: Dış kenara, Inside: İç kenara, Center: Kenarların ortasına ekler. Fill Type: Doldurma tipini seçebiliriz. Çerçeveye, Color: Renk Doldurur, Gradient: Eğim vererek doldurur, Pattern: Desen vererek doldurur (Bunlardan daha önce bahsetmiştik).

Efektleri kısaca incelemiş olduk. Ancak bunların işlevlerini görebilmeniz için mutlaka Photoshop programını temin edip, satın almasanız dahi deneme versiyonunu indirip ( deneme versiyonun da kayıt yapmaya izin verilmiyor), kendinizin deneme yanılma yöntemi ile ve sabırla uğraşarak öğrenmenizden daha kolay yolu yoktur. Biz burada sadece basit şekilde inceleyerek, ileride ihtiyaç duyduğunuzda kullanmanız için size bir kaynak yaratmış oluyoruz. 
Bu bölümde adı çok sık geçen ve Photoshop'u kullanırken çok sık kullanacağımız bazı özelliklerinden, olan "Define Pattern" , "Fill" , "Stroke" efektlerini ve "Transform" özelliklerini de incelememiz gerekmektdir. Bu efektlere, Photoshop'un Arayüzünde bulunan Edit Menüsünden ulaşabilirsiniz.
Şimdi bunları inceleyelim;
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Define Pattern:
Öncelikle "Pattern" kelimesinin Türkçe karşılğının "Desen" olduğunu hatırlamalıyız. Böylece "Define Pattern" nin de "Desen Tanımlamak" olduğunu bilmeliyiz. Yani bu özellik ile programa bir mesaj vererek, "İmajımızı bir desen ile kaplamak istediğimizi" bildiriyoruz.
Bir örnek verirsek, 10x10 pixels ebatlarında yeni bir döküman açıp, içine bir şeyler çizgik, boyadık ve efekt vererek süsleyerek bir imaj (desen) elde ettik.
Şimdi bu imajımızı daha büyük ölçülerde 100x100 pixels ebatlarında başka bir dökümanımıza desen olarak kaplamak istiyoruz. Bunu Kopyala (Ctrl+C) - Yapıştır (Ctrl+V) yöntemiyle yapmaya kalkarsak hem çok zaman alır, hemde çok uğraştırır. Ayrıcada her zaman istenen etkiyi de vermez. Bu nedenle işlemi "Define Pattern" ile yapacağız. Öncelikle, desen olarak kullanacağımız 10x10 pixels edatlarındaki dökümanımızın tamamını seçelim (Ctrl+A), [Şayet tamamını değil de bir kısmını, kullanacağımız desen olarak seçmek istersek, bunun için Araç kutusundaki seçim aracımız olan "Marquee Tool" dan birisi, örneğin, "Rectangular Marguee Tool " [image: image191.png]


(M) ile seçmimizi yapmamız gerekiyor.]
Daha sonra Edit > Define Pattern ile bu seçimimizi desen olarak programın hafızasına alırız. ( Program, Edit/Define Pattern seçimini yapınca bir pencere açarak hafızaya aldığımız desen'e bir isim vermemizi ister. Buraya bir isim yazarsak ileride kullanacağımız zaman bize kolaylık sağlayacaktır.)
Artık istediğimiz kadar Kopyala-Yapıştır yapsak da hafıza daki desen bilgisi değişmez taki başka bir Define Pattern yapıp da aynı isim ile kaydedene kadar. 
Yukarıdaki Efektler bölümünde sık sık anlattığımız "kendiniz Define Pattern ile desen yaratabilirsiniz." açıklaması bunu ifade eder. Peki oluşturduğumuz ve Define Pattern ile hafızaya aldığımız bu deseni nasıl kullanacağız? Şimdi diğer bir özellik geliyor;

Fill:
Belirli bir seçili alanı veya Layer'i bir renkle ve önceden seçilmiş bir desen ile doldurmaya, boyamaya yarar.

"Fill" Penceresi 
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Bu pencereyi açıklayalım;
Contents: Use: Doldurma işlemini yaparken neyi kullanacağımızı belirliyoruz. İmajımızı, seçime göre: Foreground; Paletteki üst renk-çizim rengi, Background; Paletteki alt renk-zemin rengi, Pattern; "Define Pattern" ile hafızaya alınan desen (resimde, önceki sayfadaki örneğimiz seçilidir.), History; Undo bekleyen geçmişteki düzeltmeler, Black; Siyah renk, %50 Gray; siyah ve beyaz rengin tam ortası, White; beyaz renk ile doldururuz.
Blending: Mode: Önceden Layer Efektlerinde açıklanmıştı (Normal, Dissolve vd.). Opacity: Doldurma işleminin imaj'a etki yüzdesi. Preserve Transparency: Bunu seçersek, yapılan işlem, Layer'deki şeffaf olmayan bölgelere etki edip, şeffaf olan bölgelere dokunmayacaktır.  

Stroke:
Kenar çerçevesi düzenler. Bir Layer'in tamamının yada içindeki imajın veya seçili bir alanın kenarlarını oluşturmak için kullanılan bir komuttur. Default olarak Paletteki Üst Renk-Boyama rengini kullanır. Ancak istenirse bu renk "Stroke" Penceresi içinden "Color Picker" den seçilen başka bir renk ile değiştirilebilir. 

"Stroke" Penceresi

[image: image193.png];

EE e

[P

22l 7= QBN

il

Stroke

om
coer: [

Location

€ inside & Center  Outside

Blending
Mode: [Narmal

Opacity: [ioo %

¥ Preserve Transparency

oK





Stroke penceresinde, Stroke, Location, Blending bölümleri bulunur. Bunlar sırasıyla;
Stroke: "Width":Çizilecek çerçevenin kalınlığını pixel cinsinden belirler. "Color": Çerçevenin rengini belirler. Default olarak Paletteki üst rengi (Foreground) kullanır. Ancak yukarıdaki resimde Kırmızı renk ile gösterilen kısma tıklarsak, açılan Color Picker'den başka bir renk seçerek çerçeve rengini değiştirebiliriz.
Location: Çizilecek çerçevenin, imajın kenarının neresine çizileceğini tespit ederiz. "Inside": Kenardan içe doğru. "Center": Kenarın ortasına. "Outside":Kenarın dışına doğru.
Blending: Bu kısım daha önce anlatılanlar ile aynı olduğu için burada ayrıca değinmiyoruz.
"Stroke" un Photoshop uygulamalarında en çok kullanılan bir komutlardan biri olduğunu hatırlatırız.

 

Define Brush:
Birçok özelliği ile Define Pattern'e benzer. Ancak bu defa, "Edit > Define Brush" ile hafızaya alınan deseni, Tool Options Bar (Araç Seçenekleri Çubuğu) daki "Brush" listesine ekler. Tool Bar'dan Paintbrush Tool (B) [image: image194.png]


aracını kullanırken, Tool Options Bar'da ki Brush listesinden hafızaya aldığımız deseni seçebiliriz. Bu taktirde Paletin boya-üst rengini kullanarak fırça etkisi ile boyar. 
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"Transform"  için imajımızı seçili hale getirdik

B. ANİMASYON
Bu bölümde animasyon konusundaki web standardı olarak kabul edilen Adobe Flash programını inceleyeceğiz. Flash Programına ait program arayüzü aşağıdaki gibidir:
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Flash program arayüzü, versiyonlar arasında değişiklik göstermekle birlikte panellerin ve araçların kullanımında önemli farklar yoktur.

1. Araç Çubukları ve Görevleri
Selection Tool: Nesnenin tamamını seçmeye yarayan araç düğmesidir.

Subselection Tool: Alt seçim aracıdır. Noktasal seçim aracıdır. Noktasal olarak seçim yapar. Şeklin çizgi yolu üzerinde seçim işlemleri gerçekleştirilebilir.  
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Free Transform Tool: Nesneyi serbest döndürme ve boyutlandırma işlemlerini yapabilmek için kullandığımız araç çubuğudur. 

Gradiant Transform Tool: Şeklin iç dolgusu ile ilgili işlemler gerçekleştirmek amacıyla kullanılan araç çubuğudur.

Line Tool: Çizgi oluşturmak amacıyla kullanılan araç düğmesidir.

Lasso Tool: Paçalı seçim yapmak amacıyla kullanılan araç çubuğudur.

Pen Tool: Noktalar arası birleştirerek şekil oluşturulması amacıyla kullanılan araç düğmesidir.

Text Tool: Metin alanı oluşturmak amacıyla kullanılan araç düğmesidir. Statik, input ve dinamik veri alanları oluşturulabilir.

Oval Tool: Daire çizimlerini yapmak amacıyla kullanılan araç çubuğudur.

Rectangle Tool: Dikdörtgen oluşturmak amacıyla kullanılan araç çubuğudur. 
Pencil Tool: Kalem aracıdır. Düz, yumuşak ve mürekkep yazım biçimleri bulunmaktadır. Bu düzenlemeler araç çubuğunun altında yer alan options bölümünden yapılabilmektedir.

Brush Tool: Fırçalı boyama işlemlerinin gerçekleştirilmesi amacıyla kullanılan araç çubuğudur.

Ink Bootle Tool: Oluşturduğumuz şeklin dış kenar çizgisinerenk vermek amacıyla kullanılır.

Paint Bucket Tool: Şeklin iç dolgu renginin doldurulmasını sağlar.

Eyedropper Tool: Herhangi bir nesneye ait rengin başk bir nesneye aktarılması amacıyla kullanılır.
Eareser Tool:  Silme işlemlerinin gerçekleştirilmesi amacıyla kullanılır. 
NOT: Fırça ve silgi araçları seçildikten sonra araç çubuğunun alt bölümünde silme ve fırça yönteminin nasıl işlem yapacağına dair seçim ekranı görüntülenir.


Bu seçim özelliği ile silgi ve fırça aracı normal, iç alan üzerinde etkili, çizgi üzerinde etkili ,seçim alnında etkili olarak kullanılabilmektedir.

2. Timeline (Zaman Çizelgesi İşlemleri)
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Animasyonun zaman içerisinde yapacağı işlemlerin tanımlandığı karelerdir. Zaman çizelgesinin sağ tarafında filmin oluştuğu layer (katman) bölümü yer almaktadır.Her katmana hareketlilik sağlanan ayrı bir nesnenin yerleşimi ve komutların ayrı bir katmanda bulunması işlemleri kolaylaştıracaktır.
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Layer katmanın alt bölümünde yeni bir katman ekleme, katmanların gruplandırılması için klasör ekleme ve katman silme işlemlerinin gerçekleştirildiği düğmeler yer almaktadır. Katman grubunun üzerinde, katmanların görüntülenmesi ile ilgili işlemleri gerçekleştiren 3’lü düğme grubu yer almaktadır.

Göz resmi: Katmanın görüntülenmesini veya gizlenmesini sağlar.

Kilit Resmi:  İşlem yaparken yanlışlıkla zarar vermek istemediğimiz katmanları korumamızı sağlar.

Dış Hat Düğmesi:  Katmanda yer alan şekillerin sadece dış çizgilerinin görüntülenmesi amacıyla kullanıla araç düğmesidir.

3. Scene (Sahne) İşlemleri
Flash programını çalıştırdığımız zaman karşımıza gelen beyaz geniş boş alan çalışma sahnemizdir. Tüm tasarımlar bu sahne üzerinde gerçekleştirilmektedir. 

Size: Çalışma ekranın genişliğinin ayarlanması amacıyla kullanılan düğmedir.

Background: Çalışma belgesinin arka plan renginin düzenlenmesini sağlar.

Frame Rate: Birim saniyede çalıştırılacak kare sayısının ayarlanmasını sağlayan seçenektir. 
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4. Tweening (Kare Doldurma) İşlemleri
2 farklı kare doldurma işlemi vardır. Bunlar shape (şekil) ve  motion (hareket) kare doldurma işlemleridir. Şekil kare doldurma işlemleri şeklin bir nesneden başka bir nesneye dönüşüm işlemlerinin yapılması amacıyla kullanılır. Hareket kare doldurma işlemi ise şeklin bir konumdan başka bir konuma hareketi, boyutunun değişimi ve renginin değişimi gibi işlemleri gerçekleştirmek amacıyla kullanılır.

Daha önce Flash programlarında animasyonların karelerdeki görüntülerden oluştuğunu söylemiştik. Örneğin bir kelebeğin kanadını çırpmasını animasyonla ifade edeceksek her bir hareketi ayrı ayrı karelere yerleştirmemiz gerekecektir.
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Peki her zaman animasyonları böyle kare kare hazırlamamız gerekecekse o zaman Flash’ın bize sağlayacağı avantaj nedir? Tabii ki bütün bir animasyonu bu şekilde kare kare çizerek hazırlamak zorunda olsaydık Flash’ın bize sağlayacağı bir avantaj olmayacaktı. Ama Flash programını hazırlayan mühendisler bunu önceden düşünerek Flash içerisinde Motion Tween ve Shape Tween adında 2 adet animasyon çeşidi yerleştirmişler. Bu 2 tween işleminde de temel mantık şudur. Kullanıcı animasyonun başlangıç ve bitiş hareketini tanımlar, bu iki nokta arasındaki hareketi Flash programı kendisi tamamlar.

4.1 Motion Tween

Bu Tween çeşidinde renk değişimi, boyut değişimi ve konum değişimi gerçekleştirilebilir. Örneğin herhangi bir kare veya dikdörtgeni aşağıdaki gibi bir A konumundan B konumuna getirirken renginin solmasını veya başka bir renge dönüşmesini sağlayabiliriz.
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Şimdi Flash programında basit bir Motion Tween animasyonu gerçekleştirelim. 
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Şekilde görüldüğü gibi boş bir Flash çalışması açtım ve daire çizim aracını seçerek bir adet daire çizdim. Yani şu anda birinci Frame de bir adet dairem mevcut. Eğer bu 1 numaralı frame’i seçtikten sonra alt bölümde yer alan Properties penceresini açarsak burada Tween seçeneğinin yanında None seçeneğinin seçili olduğunu görürüz.
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Şu anda bu Frame’im herhangi bir Tween işlemine hazır değildir. Ben Motion Tween işlemi gerçekleştirmek istediğim için bu frame in Tween özelliğini Motion olarak belirlemem gerekir. O halde yandaki pencerede Tween seçeneğini Motion olarak belirliyorum.

Ayrıca hemen hatırlatalım. Eğer Motion Tween uygulaması yapmak istiyorsak çizimimizin bir Sembol veya Movie Clip olması gerekmektedir. Aksi halde Motion Tween uygulamasını gerçekleştiremeyiz. O halde bu çizmiş olduğumuz çemberi seçerek klavyeden F8 tuşuna basıyoruz. Bu tuşa bastığımızda karşımıza Convert to Sembol iletişim penceresi gelecektir.
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Burada Movie Clip veya Graphic seçeneklerinden birini seçmek suretiyle çizimimizi sembole dönüştürebiliriz. Biz Graphic seçeneğini kullanarak çizimimizi Graphic olarak tanımlıyoruz. Daha sonra 10. Frame’e gelerek klavyeden F6 (Insert Key Frame) tuşuna basıyoruz.

Şekilde görüldüğü gibi 10. Frame üzerinde klavyenin F6 tuşuna basıldığında 10. Frame’e bir adet anahtar kare yerleştiriliyor ve kadar olan bütün Frame’ler içerisine 1. Framedeki görüntü kopyalanıyor. Frameler üzerindeki ok kesintisiz olduğundan Motion Tween uygulamasını doğru bir şekilde gerçekleştirdiğime emin olabilirim. Şu anda bu çalışmamı çalıştırırsam herhangi bir değişiklik olmayacaktır. Çünkü benim başlangıç (1) ve bitiş (10) framelerimdeki görüntü aynı. O halde ben bitiş Framelerimdeki görüntüyü biraz değiştirerek animasyonu sağlamalıyım.

Ben 10. Frameimi seçiyorum ve bu frame seçili iken çemberimin bulunduğu pozisyonu değiştiriyorum. Ayrıca rengini veya büyüklüğünü de değiştirebilirim.

Çember seçili iken alt tarafta yer alan Properties panelinde yer alan Color seçeneğini kullanarak çemberimin rengini de değiştiriyorum.
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Görüldüğü gibi 10. Frame’i seçtim klavyeden F6 tuşuna bastım. Böylece Flash benim için 10. Frame’e bir KeyFrame ekledi ve 1. Frame’den 10. Frame’e kadar kopyaladı. 10.Frame’i seçtikten sonra bu frame’de yer alan görüntümün yerini, boyutunu ve rengini değiştiriyorum. Böylece Flash programına animasyonun bitiminde sembolümün ne durumda olmasını istediğimi belirtiyorum. Flash programı da 1. Frame deki görüntünün 10. yani son framedeki görüntüye dönüşebilmesi için gerekli değişiklikleri aradaki framelere yansıtıyor. Yani bizi ilgilendiren 1. Frame ve 10. Frame. Aradaki animasyonu Flash kendisi gerçekleştiriyor.
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Şimdi klavyeden Ctrl+Enter tuşlarına basarak veya Control menüsünden Test Movie seçeneğini işaretleyerek animasyonunuzu test edebilirsiniz.

Motion Tween Animasyonlarda Klavuz Katman Kullanımı:
Motion Tween animasyonları özelliği, animasyonun yalnızca başlangıç ve bitiş karelerini tasarlamamızdır. Flash programı geri kalan hareketi kendisi tamamlayacaktır. Flash programı bu işlemi gerçekleştirirken iki nokta arasını doğrusal bir yol ile belirlemektedir.

Eğer biz farklı bir yol belirlemek suretiyle Flash programının bu yolu takip etmesini istiyorsak o zaman bir klavuz katman kullanmalıyız.
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Şekil 2 ‘de görüldüğü gibi farklı bir yol belirlemek istiyorsak bir adet Klavuz Layer kullanmamız gerekir.

Şimdi böyle bir uygulamayı hazırlamaya çalışalım.
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Önce boş bir Flash dosyası açalım ve bir adet daire çizelim. Bu dairemi çizmiş olduğum Layer’ın ismini daire olarak değiştiriyorum.
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Şimdi Insert-Layer menüsünü kullanarak bir adet katman daha ekliyoruz. Bu katman da bizim klavuz katmanımız olacak. Bu katmanın da özelliklerini açarak ismini klavuz, tipini de Guide olarak belirliyoruz. Hareketimiz sırasında kullanmak istediğimiz klavuz yolumuzu bu katmanda hazırlayacağız. Nesnemizin de bu katmandaki çizimi klavuz olarak görmesini sağlamak amacıyla bu katmanın özelliğini Guide olarak belirledik.

Şimdi klavuz katmanımıza hareket sırasında kullanılacak yolu çizmemiz gerekiyor. Bu işlem için Pen aracını kullanabilirsiniz.
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Şimdi dairemizin yer aldığı layerda 1.Frame’de sağ tıklayarak Create Motion Tween seçeneğini seçiyoruz.

Şimdi daire isimli Layer’ımızda 20. Frame’e bir adet anahtar kare (Key Frame) ekliyoruz. Bunun için 20. Frame’i seçerek F6 tuşuna basmanız yeterli olacaktır.
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20. Frame’e bir adet anahtar kare ekledikten sonra dairemizi A noktasından B noktasına doğru klavuzu takip ettirmek suretiyle taşıyoruz.

CTRL+Enter tuş kombinasyonunu kullanarak animasyonunuzu test edebilirsiniz.

4.2 Shape Tween
Flash programında gördüğümüz ikinci tip animasyonlar da Shape Tween animasyonlardır. Motion Tween animasyonlarda nesnelerin konumları, boyutları ve renkleri değiştirilebilmekteyken Shape Tween animasyonlarda bir nesne başka bir nesneye dönüştürülebilmektedir.

Shape Tween animasyonları kullanılarak bir yazıyı başka bir yazıya veya bir daireyi dikdörtgene dönüştürebilirsiniz.

Motion Tween animasyonlarda harekete katılan çizimlerin Convert to Symbol iletişim penceresi kullanılarak (veya klavyeden F8 tuşuna basılarak) Nesneye (Graphic,Movie Clip veya butona) dönüştürülmesi gerekirken Shape Tween animasyonlarda Salt çizim (yani nesne olmaması) gerekmektedir.

Şimdi basit bir Shape Tween animasyon hazırlayalım.

Önce boş bir Flash çalışması açalım ve Oval (daire) çizim aracını kullanarak bir adet daire çizelim.

 


Bu daireyi çizmiş olduğumuz 1 nolu Fame seçili iken alt bölümde yer alan Properties penceresini açarak Tween özelliğini Shape olarak belirleyelim.

Şimdi 25. Frame’i seçerek klavyeden F6 tuşuna basıyoruz. (F6 tuşuna bastığımızda bir adet anahtar kare eklenecektir.) Anahtar kareler 
Motion ve Shape Tween animasyonlarda kullanılan özel animasyon karelerdir. 

Biz dönüşüm işlemi yapmak istiyoruz. Fakat şu anda 1 nolu Frame ile 25 nolu Frame’de aynı görüntü mevcut. Bu yüzden tam bir dönüşüm işlemi gerçekleşmeyecektir. Biz son Framedeki daireyi silerek yerine bir adet dikdörtgen çizelim. Böylece 1. Frame’deki daire 25. Frame’e kadar dikdörtgene dönüşecektir.

Şimdi başka bir Shape Tween örneği yapalım. Yine boş bir belge açalım ve büyük font kullanarak I harfi yapalım.

Yandaki şekilde görüldüğü gibi boş bir Flash dosyası açtık ve metin aracını kullanarak Arial Narrow fontunu kullanarak bir adet büyük I harfi yazdık. Bu harfi Shape Tween yöntemi ile T harfine dönüştürmek istiyoruz. Bu işlemin 20 Frame içerisinde gerçekleşmesini istiyoruz. Bu yüzden 20 nolu Frame üzerinde farenin sağtuşuna basarak açılan menüden Insert Blank Key Frame seçeneğini seçelim


Daha önceki örneğimizde Insert Keyframe seçeneğini seçmiştik. Insert Keyframe seçeneğini eklediğimiz yere kadar ilk frame’in kopyasını atıyordu. Insert Blank Keyframe seçeneği ise boş bir anahtar kare ekler.Bizim örneğimizde 20 nolu framee bir adet blank keyframe ekledik. Böylece ilk 19 frame 1.frame’in aynen kopyası olarak eklendi. Fakat 20 nolu Frame boş olarak hazırlandı. Biz bu 20 nolu Frame’e T harfini yazalım



Şimdi 20 nolu Frame’imize de T harfini yazdık. Fakat daha önce Shape Tween animasyonlarda animasyona giren çizimlerin Salt çizim olması gerektiğini söylemiştik. Burada ise bizim harflerimiz henüz çizime dönüştürülmedi. Halen yazı durumundalar. Bu yazılarımızı çizime dönüştürmek için Modify-Break Apart seçeneği kullanılmadır. Önce 20 nolu frame’de yer alan son nesnem olan T harfini seçerek bu komutu uyguluyorum. Daha sonra da 1 nolu frame’de yer alan I harfini seçerek bu komutu uyguluyorum. Böylece bu harfleri birer çizime dönüştürmüş oluyorum.

Şu anda Framelerimize dikkat edersek halen gri renkli görünüyorlar. 

Biz bu framelerin özelliğini henüz Shape Tween’e uygun hale getirmedik. Bu işlemi gerçekleştirmek için bu frame’leri seçiyoruz ve aşağıda yer alan properties penceresinden Tween özelliğini Shape olarak ayarlıyoruz.



Eğer yapmış olduğumuz animasyonu çalıştırırsak şekildeki gibi bir görünümle karşılacağız. I harfimizin ortasında T harfinin üst kısmı oluşturulacaktır. Eğer biz Shape Tween işleminin gidiş yönünü değiştirmek ve kendimize göre bir dönüşüm ayarlamak istersek o zaman Shape Hints leri kullanmalıyız. Böyle bir şeye ihtiyacımız olduğu durumlarla karşılaşabiliriz.

Örneğin yukarıdaki şekildeki gibi bir Shape Tween işlemimizin olduğunu varsayalım. Burada 1. şekilde görülen çizgi 2. şekilde görülen daireye dönüştürülmektedir. Eğer bu dönüşüm sırasında 1. şekildeki A noktasının 2. şekildeki A noktasına, 1 şekildeki B noktasının 2. şekildeki B noktasına gelmesini istiyorsak o zaman Flash programında yer alan shape Hintslerden faydalanmalıyız.

Şimdi kendi örneğimize geri dönelim. 1 nolu frame’e gelerek buraya 2 adet Shape Hint ekleyelim. Bunu yapabilmek için Modify menüsünden Shape ve oradan da Add Shape Hints seçeneğini kullanıyoruz. Bu komutu bir defa verirsenin sadece a isimli shape hint’i ekleyecektir. Bu işlemi tekrarlamaya devam ederseniz b,c… şeklinde isimlendirmeye devam edecektir. Şimdi 1. Frame’de yer alan I harfine 2 adet Shape Hint eklemiş olduk. Tabiî ki biz buraya 2 adet shape hint ekledikten sonra 20 nolu frame’e de aynı shape Hintler eklenmiş olacaktır. Bunların yerlerini ayarlamak suretiyle dönüşüme istediğimiz şekilde müdahale edebilmekteyiz.

5. Sahneye Hazır Filmler ve FLV (Flash Video) Dosyaları Eklemek

Flash sahnesine daha önceden hazırlanmış swf uzantılı flash filmleri, farklı formatlarda resim dosyaları ve flv uzantılı Flash Videoları eklenebilir. Bu işlem için bazı ActionScript kodlarını kullanmak gerekecektir.

loadMovie() Komutu: loadMovie() komutu fonksiyon olup SWF, JPEG, GIF ve PNG dosyalarını Flash sahnesindeki bir Movie Clip nesnesine ya da doğrudan sahne içine ekler. Hareketli GIF’lerin yalnızca ilk karesi eklenir. Bu fonksiyon bazı parametrelerle birlikte kullanılır. Bu parametreler fonksiyona hangi dosyanın yükleneceğini, dosyanın nereye yükleneceğini ve bazı değişkenlerin nasıl gönderileceğini belirtir. Bu fonksiyon birden fazla SWF dosyasının tek seferde gözükmesini sağlar ve yeni bir HTML sayfası yüklemek zorunda kalmadan SWF dosyaları arasında geçiş yapılabilir.

Kullanımı:
loadMovie(url:Metin , hedef:Nesne, [yöntem:Metin) : Void

loadMovie(url:Metin, hedef:Metin, [yöntem:Metin]) : Void

Parametreleri

- url: String(Metin Dizisi)= Yüklenecek dosyanın bağıl ya da mutlak yoludur. Bağıl yol üzerinde çalışılan SWF dosyasına sıfır seviyesine (level 0) göre bağıl olmalıdır. Diğer bir ifadeyle referans noktası üzerinde çalışılan SWF dosyasının kendisidir. Mutlak yolda http:// ya da file:/// gibi fiziksel başlangıç noktaları belirtilir.
- target (hedef): Object/String(Nene ya da Metin Dizisi)= Yüklenecek dosyanın sahne içindeki bir movie clip nesnesine referansını belirtir. Movie clip nesnesi yüklenen SWF dosyası ya da resimle değiştirilir. Nesne olarak sahne içinde yer alan bir movie clip nesnesinin adı yazılır.

Eğer SWF ya da JPEG dosyaları belli bir seviyeye göre yüklenecekse loadMovie() fonksiyonu yerine loadMovieNum() fonksiyonu kullanılır. Hedef (target) değeri olarak 1,2,3… gibi sayısal değerler kullanılır.
- method (yöntem): String (Seçmelidir)= Değişkenlerin gönderilmesi için bir http yöntemi belirtir. Parametre GET ya da POST olmalıdır. Gönderilecek değişken yoksa bu değer kullanılmaz.
loadMovie() fonksiyonuyla yüklenen SWF dosyaları ve resimleri unloadMovie() fonksiyonuyla uzaklaştırılır.
Kullanım Örnekleri:
Kullanım-1: Aşağıdaki örnekte üzerinde çalışılan Flash filmiyle aynı düzeyde bulunan arayuz.swf isimli Flash dosyası yüklenir ve sahnede yer alan den isimli movie clip nesnesiyle yer değiştirilir. Yüklenen SWF dosyası sahnede yer alan den isimli nesnenin sol üst köşe noktası koordinatlarına yerleştirilir.
loadMovie(“arayuz.swf”, den);

//Eş değer ifade: loadMovie(“arayuz.swf”, _level0.den);
Kullanım-2: Aşağıdaki örnekte movie clip nesnesi ya da seviye belirteci çift tırnak içinde yazılmıştır.
loadMovie(“arayuz.swf”, “den”);

//Eş değer ifade: loadMovie(“arayuz.swf”, “_level0.den”);
Kullanım-3: Aşağıdaki örnekte yalnızca seviye belirteci yazılmış olup SWF dosyası _level0’ın zaman doğrusuna doğrudan yüklenmektedir.
loadMovie(“arayuz.swf”, _level0);

_levelN: Bir referans belirtecidir. _level belirteci kullanılmadan önce Flash

oynatıcısına SWF dosyalarını yüklemek için loadMovieNum() fonksiyonu kullanılmalıdır. N sayısal bir değerdir ve Flash oynatıcısına yüklenecek SWF dosyasının seviyesi bildirilir.
Flash oynatıcısına yüklenen ilk SWF dosyası otomatik olarak _level0 düzeyine yüklenir. _level0 düzeyine yüklenen SWF dosyasının zemin rengi (background color), çerçeve oranı (frame rate) ve çerçeve boyutu (frame size) alt sıralara yüklenen diğer SWF dosyaları için varsayılan değer olur. Daha sonra SWF dosyaları seviye değerlerine göre yığına alınır.
loadMovieNum() fonksiyonuyla yüklenen her SWF dosyası için bir yığın numarası verilmelidir. Eğer daha önceden atanmış bir numara verilecek olursa yeni SWF dosyası öncekinin yerini alır.
Ör: loadMovieNum(“deneme.swf”, 1);

Aşağıdaki örnekte benimButonum adlı düğmeye tıklayınca den isimli movie clip nesnesine yüklenmiş olan deneme.swf dosyasının yerine image1.jpg resmi yüklenir.
benimButonum.onRelease = function(){

loadMovie(“image1.jpg”, den);

};

Uygulama: Sahneye (stage) flv dosyası (flash video file) eklenmesi
1- Öncelikle FLV uzantılı bir flash video dosyası temin ediniz. (Not : http://www.helpexamples.com/flash/video/ adresinden örnek flv dosyaları alabilirsiniz.)

2- Temin ettiğiniz FLV dosyasının boyutlarına uygun genişlik ve yükseklikte bir flash çalışma sayfası açınız.

3- Window → Library komutuyla kütüphane penceresini açınız.

4- Pencerenin sağında bulunan simgeye ([image: image203.emf]) tıklayınız ve şekil 6.23’teki menüyü açınız. Menüden New Video… komutuyla Video Properties penceresini açınız.

[image: image204.emf]
Flash kütüphanesine yeni bir video nesnesinin eklenmesi

[image: image205.emf]
Video simgesinin sahneye sürüklendikten sonra sahne içindeki görünümü

5- Video türü olarak Video (ActionScript-controlled) değerini seçiniz. Video ismi olarak oynat adını veriniz. Yaptığınız işlemi onaylayınız.

6- Kütüphane penceresine eklenen oynat isimli video simgesini sahneye

sürükleyiniz.

7- Çalışma sayfasında yer alan Şekil 6.24’tekine benzeyen şekli seçiniz ve

Properties panelinde <Instance Name> yazan yere filmim yazınız.

8- Timeline panelindeki Layer 1 isimli katmanın adını video olarak değiştiriniz.

9- video katmanını seçin ve Actions panelini açarak aşağıdaki kodu yazınız.
var baglantim:NetConnection = new NetConnection();

baglantim.connect(null);

var my_ns:NetStream = new NetStream(baglantim);

filmim.attachVideo(my_ns);

my_ns.play("0105.flv");// flv dosyası çağrılır.

10- Flash filmini oynatarak sonucu izleyiniz. Kendi FLV dosyalarınızı oluşturmak istiyorsanız MOV uzantılı QuickTime dosyalarını ya da WMV uzantılı Windows medya dosyalarını uygun bir kodlayıcıyla dönüştürmeniz gerekir. Bunun için “Flash Video Encoder” yazılımı kullanılır. Bu yazılımı temin ettiğinizde dönüştürmek istediğiniz medya dosyası program içerisine sürüklenir ve gerekli düzenlemeler yapıldıktan sonra medya dosyasının FLV uzantılı bir kopyası elde edilir. Bilgisayarınızın işlemci performansı ve video dosyasının boyutu dönüşüm süresini etkiler.

6. Karmaşık Etkileşime Girmek
Flash’ın ActionScript dili çok sayıda eylem grubu içermektedir. Bu eylem gruplarıyla ana filmdeki nesneleri düzenlemek, bazı koşulların doğruluğunu test etmek, kullanıcı girdisi oluşturmak, diğer filmlerden ve dosya tiplerinden bilgi almak, XML uygulamalarıyla web tabanlı veri sorgulaması uygulamaları gerçekleştirmek gibi pek çok eylem gerçekleştirilebilir.

Bu tür script’ler yazmanın anahtarı, değişkenlerle (variables) ve ifadelerle  (expressions) çalışmaktır. Bu öğeler yardımıyla, kullanıcılara daha doğrudan ve kişisel tepkiler veren siteler yaratabilirsiniz. ActionScript dili yazım biçimi olarak (syntax düzeni) JavaScript dilini andırır. Matematiksel ve mantıksal tüm işaretler ve değişkenler neredeyse JavaScript ile aynıdır.
6.1. ActionScript Kullanarak Çeşitli Uygulamalar Tasarlamak

Veri girişine dayalı bir uygulamanın tasarlanması

1- Yeni bir Flash filmi oluşturunuz.

2- Araç kutusundan metin aracını (Text Tool) seçiniz.

3- Çalışma alanında Yaş, Gün, Ay ve Yıl yazılarını içeren alt alta dizili dört ayrı metin kutusu oluşturunuz.

4- Properties panelinde metin türü olarak Input Text değerini seçiniz ve Yaş, Gün,

Ay ve Yıl yazılarını yazdığınız metin kutularının yanında boş metin kutuları oluşturunuz.
[image: image206.emf]
Metin kutusu için Input Text değerinin seçilmesi

5- Yaş kelimesini içeren metin kutusunun yanında oluşturduğunuz Input Text modundaki boş metin kutusunu seçiniz ve Properties panelinde Var: etiketinin yanındaki alana yas değişken değerini giriniz.

6- Aynı şekilde Gün yazısının yanındaki metin kutusunu seçiniz ve Var: etiketinin yanındaki alana gun değişken değerini giriniz. Ay ve Yıl yazılarının yanındaki metin kutularına da sırasıyla değişken adı olarak ay ve yil değerlerini giriniz.

7- Yas değişkenli boş metin kutusunu seçiniz ve metin alanına yazılacak değerin uzunluğunu kısıtlamak için Properties panelinde Maximum Characters: etiketinin yanındaki alana 2 değerini giriniz.
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Input Text türündeki yas değişkenli metin kutusu üzerinde çeşitli değişikliklerin yapılması

8- Diğer Input Text türündeki metin kutuları için de karakter sınırlaması

yapabilirsiniz. yas’, gün’, ay ve yil değişkenli metin kutuları sayısal değerler içereceğinden yanlışlıkla alfa nümerik bir karakterin girişini engellemek için şekilde gösterildiği gibi Character düğmesine tıklayınız ve çıkan iletişim penceresinde Only radyo butonunu, ardından Numerals (0-9) değerini seçiniz.

9- Ok aracını seçiniz ve çalışma alanında boş bir yere tıklayarak üzerinde çalıştığınız metin kutusunu seçili durumdan kurtarınız.

10- Metin aracını seçiniz ve çalışma alanının uygun gördüğünüz bir yerine metin kutusunu çiziniz.

11- Properties panelinde metin türü olarak Dynamic Text değerini seçiniz. Var: etiketinin yanına sanslisayi değişken adını yazınız.
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Dynamic Text türündeki metin kutusunda değişken adının belirlenmesi

12- Window → Common Libraries → Buttons komutunu çalıştırınız ve çalışma

alanına bir buton yerleştiriniz.

13- Butonu seçiniz. Window → Acitons komutunu çalıştırınız ve karşınıza gelen eylem penceresinde - View Options düğmesine tıklayarak Normal Mode kod yazım modunu seçiniz.

14- Eylem penceresinin sol tarafında yer alan eylem listesinde Actions → Movie Control eylemlerini seçtikten sonra on deyimi üzerine çift tıklayarak kod yazım alanında on(release){ } deyiminin oluşmasını sağlayınız.

[image: image209.emf]
On deyiminin seçilmesi

15- Yine Actions eylem grubunu seçiniz ve çıkan listeden Variables eylem grubunu seçiniz. Bir değişkene değer ataması gerçekleştirmek üzere set variable eylemine çift tıklayınız.

16- Kırmızıyla vurgulanmış <not set yet> (henüz ayarlanmadı) kelimelerini görmeniz gerekir. Bu yazıyı seçiniz ve Variable (Değişken) alanına _root.sanslisayi değişken adını giriniz.

17- Value alanına
Number(_root.yas) + Number(_root.gun) + Number(_root.ay) + Number(_root.yil) 
kodunu yazınız. Value alanının sağındaki Expression (İfade) onay kutusunu işaretleyiniz. Böylece bu dört değişkenin içeriğini de toplayacak matematiksel bir ifade oluşturmuş oldunuz.

18- Control menüsünden Test Movie komutunu çalıştırın ve ilgili kutulara değerleri giriniz.

 _root deyiminin sırrı: Burada _root (kök) deyimi atıfta bulunulan değişkenin hiyerarşik düzende çalışma alanının en üst noktasında olduğunu belirtmektedir. Yazmış olduğunuz kod düğme nesnesinin içinde yer aldığı için _root deyiminin yazılmaması durumunda değişkenler düğme nesnesinin içinde aranacaktır. Böylece Flash’a söz konusu değişkenleri düğme içinde değil, sahnenin kendi zaman doğrusunda aramasını sağlamış oluruz. 
7. Flash Terimleri
	A

	actions
	Flash içerisinde yazılan program kodları

	align
	Hizalamak

	align center
	ortaya hizala

	align justify
	iki yana yasla

	align left
	sola hizala

	align right
	sağa hizala

	B

	Background color
	Arkaplan rengi

	bitmap
	bit işlem resmi (Flash içerisine dışardan alınmış dahil edilmiş resimler.) 

	brush tool
	Fırça Aracı

	C

	Clear Frames
	Frameleri tamamen silme sadece içlerindeki görüntüyü sil.

	clear keyframes
	Anahtar kareleri temizle

	color mixer
	Renk Karıştırıcı

	convert to blank keyframes
	boş anahtar kareye çevir.

	convert to keyframes
	anahtar kareye çevir

	convert to symbol
	sembole dönüştür.

	copy frames
	seçili frameleri kopyala

	create motion tween 
	motion tween animasyonu oluştur.

	cut frames
	seçili frameleri kes

	D

	distort
	Çarpıtmak

	document
	Flash'ta çalışılan dokuman

	dynamic text
	Kodlama Yapılırken dinamik değişmesi istenen metinler için kullanılır

	E

	eraser Tool
	Silgi Aracı

	export
	Flash içerisindeki dosyayı farklı biçimde dışarıya kaydet

	export image
	Çalışmayı resim olarak yayınla

	export movie
	Çalışmayı animasyon olarak kaydet

	Eyedropper Tool
	Farklı bir rengin renk kodunu öğrenmek için kullanılır.

	F

	fla
	Flash içerisinde çalışılan taslak dosya (düzenlenebilir)

	Frame
	Film Karesi

	frame rate
	Saniyede gösterilen film karesi sayısı.

	G

	grid
	Izgara

	guides
	Klavuz Çizgileri

	H

	height
	Yükseklik

	hide all layers
	Bütün Layerları gizle

	hide panels
	Panelleri gizle

	history
	Önceki işlemlere ulaşmak için kullanılan panel.

	I

	ink bottle tool
	Çizgi rengi değiştirmek için kullanılır.

	import
	Dışardan Flash içerisine bir dosya al

	import to library
	kütüphane içerisine dışardan bir dosya al

	import to stage
	sahne içerisine dışardan bir dosya al

	insert
	Ekle

	insert blank keyframe
	Boş anahtar kare ekle

	insert frame
	Boş film karesi ekle.

	insert key frame
	Anahtar kare (Motion ve Shape Tween animasyonlarda hareketin başlangıç ve bitişi anahtar karelerle belirlenir. Kısayolu F8) 

	L

	Lasso Tool
	Daha serbest seçimler için kullanılır

	Layer
	Çizim Katmanı

	Layer Properties
	Layer özellikleri

	library
	Kütüphane

	line tool
	Çizgi aracı

	Lock all layers
	Bütün Layerları kilitle

	M

	make default
	Ayarları ilk haline döndür

	Modify
	değiştirmek,düzenlemek

	Motion Guide
	Hareket Klavuzu (Motion Tween Animasyonlar için hareket yolu)

	motion tween
	Hareket ikizi

	N

	new symbol
	Yeni sembol ekle (Movie Clip,Button veya Graphic) 

	O

	open external library
	Başka bir çalışmanın kütüphanesini aç.

	open recent
	Son çalışılan dosyalardan birini aç

	Options
	Seçenekler

	Oval tool
	Daire çizmek için kullanılır.

	P

	page setup
	Sayfa Ayarları

	paint bucket tool
	Boya Kovası aracı

	Panels
	Yardımcı Pencereler

	paste frames
	daha önce hafızaya alınan frameleri yapıştır.

	pencil tool
	kalem aracı

	preferences
	Tercihler

	preview mode
	Ön izleme modu

	Properties
	Özellikler

	Publish
	Animasyon,web sitesi … olarak yayınla

	publish preview
	Yayınlama öncesi önizleme

	publish settings
	Yayınlama ayarları (Animasyon,web sayfası,resim dosyası vs. yayınlar) 

	R

	rectangle tool
	dikdörtgen çizmek için kullanılır.

	remove frames
	Seçili frameleri kaldır (Sil)

	reverse frames
	Frameleri ters çevir

	Ruler
	Cetvel 

	S

	Scale
	Boyutlarını değiştirmek

	Scene
	Senaryo

	selection tool
	Seçim araçı

	Shape
	Flash çizim araçları ile çizilmiş ve symbol'e dönüştürülmemiş şekilller.

	shape tween
	Şekil ikizi

	show all layers
	Bütün Layerları göster

	show all layers as outlines
	Bütün Layerları taslak görünümünde (Çizimlerin sadece çizgileri) göster.  

	show panels
	Panelleri göster

	snap align
	Diğer nesnenin konumuna göre yapış

	snap to grid
	Izgaralara yapış

	snap to guides
	Klavuzlara Yapış

	snap to objects
	Nesneye yapış.

	Snapping
	Yapışma özelliği

	Stage
	Sahne

	static text
	Sadece değişken olmayan bir metin gösterileceğinde kullanılır.

	Stroke
	Çizgi

	Swf
	Animasyon olarak kaydedilmiş düzenlenemeyen dosya.

	T

	test movie
	Flash filmini izlemek için kullanılır. (Ctrl+Enter kısayolu) 

	Text
	Metin

	Text tool
	Yazı aracı

	Timeline
	Zaman Çizgisi

	Tools
	Araçlar

	Transform
	Biçim Değişikliği

	U

	unlock all layers
	Bütün Layerların kilidini aç

	W

	Width
	Genişlik

	X
	Nesnenin X eksenindeki konumu

	Y
	Nesnenin Y eksenindeki konumu
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1.  Framedeki görüntü





2.  Framedeki görüntü





3.  Framedeki görüntü
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İlk Frame deki görüntü





Son Frame deki görüntü





İzlenecek Yol





ŞEKİL 2





İlk Frame deki görüntü





Son Frame deki görüntü





İzlenecek Yol





ŞEKİL 1





Layer’ın ismini değiştirmek için buradaki boş belge simgesinin üzerinde çift tıklamak suretiyle Layer Properties penceresini görüntülüyoruz. Katman ile ilgili tüm özellikler bu pencereden düzenlenebilir.





Eğer  katmanın özelliğini GUIDE (Klavuz) olarak belirlerseniz katmanın sol tarafındaki boş belge resminin yerine bir çekiç resmi göreceksiniz. Şekilde görüldüğü gibi Klavuz katmanımıza hareket sırasında izlenecek yolu çizdik. Artık bu katman ile işimiz bitti. Son olarak bu katmanı kilitleyip istemeden zarar verme ihtimalimizi ortadan kaldırıyoruz.





Şimdi alt katmanımızın özelliğini de Guided olarak belirlememiz gerekiyor. Çünkü bu katmanda yer alan daire resmimiz hareketi sırasında üstünde yer alan klavuz katmandaki yolu takip edecek.





Son olarak da dairemizin klavuza tam olarak yapışması için Snap butonuna basıp seçili hale getiriyoruz.





Şimdi klavuz katmanımızın hareket boyunca görüntülenmesini sağlamak amacıyla 20 kareye giderek bir adet KeyFrame ekliyoruz. Bu işlemi gerçekleştirmek üzere 20. Frame’e giderek F6 tuşuna basmaktır.
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Şu anda 25. Frame’e bir adet anhtar kare ekledik. Insert Key Frame seçeneğini kullandık. Insert Key Frame seçeneği 1. Frame’in aynısını sonuna kadar kopyalayacaktır. Yani şu anda elimizde 25 adet aynı Frame’den var.





Görüldüğü gibi 25 nolu Frame’de yer alan daireyi sildik ve yerine bir adet dikdörtgen çizdik. Yukarıda görülen Tween işlemimiz tam bir ok (kesintisiz) olduğunda Tween işleminin doğru bir şekilde gerçekleştiğini düşünebiliriz. Şimdi Ctrl+Enter tuşuna bastığımızda veya Test menüsünden Test Movie seçeneğini seçtiğimizde animasyonu izleyebiliriz.
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Bu da 20 nolu Frame’de yer alan çizimimiz. Gördüğünüz gibi 2 adet Shape Hint de buraya eklenmiş durumda. 
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